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Introduction

1.1

Purpose of Document

This document is to provide some guidance to PETRA and PetraSeis system administrators working with
large numbers of people in multiuser environments. It is assumed the reader has attended product overview
training or has equivalent knowledge of the software already, and is looking for tips and techniques to better
organize and manage typical project data, and general suggestions to minimize bottlenecks in the workflow. To
improve readability of this document, we will shorten the references to PETRA and PetraSeis to just a
reference to PETRA. Topics specific to PetraSeis will be so designated.
PETRA is designed for fast, efficient access to a well database. It can handle large numbers (hundreds of
thousands) of wells in a single project and provide simultaneous access to multiple user's per project. The
project database is designed to allow many people to share the well data, but to have a separate area to store
their own "look and feel" templates and parameters.
One of the advantages of using PETRA is that it is extremely easy to create new projects and load data into
the projects. However, in large, multiuser environments, that flexibility can make it more difficult to manage the
projects when the number and physical size of the projects gets large. There have been a number of tools,
techniques, and optional features added to PETRA over the years to address this environment, and they are
described in this document.

1.2

Project Data Organization and Concepts

PETRA PROJECTS
PETRA stores all the data relevant to a particular area as a project. The Project Name is used to create the
necessary directory structure on a local drive or Windows network server. For the purposes of this document,
it is assumed the data is not on a local c: drive, but on a file server on the LAN. Well data is shared by all
members of the team and stored in a common, "public" area on a network server. Individual "look and feel"
information, such as log curve color choices and map templates are stored in a "private parameter" area that is
unique for each team member. This topic is discussed in the PETRA overview class, so it will not be covered
in detail here. If you are unsure of this structure, please refer to your overview training material. The main thing
to remember is that shared projects will have one set of database tables that all team members have access to,
and a unique set of database tables for each user connected to (or sharing) the project. To determine where
the data files for a particular project reside, just open the project in PETRA and click on the "Project" tab in
the main module. It will display the path to the public data and the path to your private data.
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Example of a PETRA Project Database Organization in a Multi-User Environment
WELL SEQUENCE NUMBER (WSN)
Each well that is stored in the PETRA database must have a different "Unique Well Identifier" (UWI). The
UWI is a 1 to 20 character identifier and is typically the API number of the well. The database assigns a
unique "Well Sequence Number" (WSN) which is used for data retrieval.
ZONES and USER-DEFINED DATA
PETRA allows an unlimited number of user-defined data fields to be stored for a well. These data are
organized into groups called "zones". A zone is like a table containing one or more columns containing
numeric, date, or text data. Each row in the table is represented by a well.
Zones are defined by a name and description and depth interval reference. Typically, the depth interval will
reference formation tops stored in the FmTops table.
Zones allow efficient organization and management of geological well data. Items such as isopach, net pay and
average porosity can be grouped together for different formation zones.
CARTOGRAPHIC DATA
Geologic interpretations (such as contour lines and fault lines), georeferenced images (topo maps or geoorthophoto quads), map titles, text boxes, and legends are stored in the map overlay file and can be segregated into
up to 256 layers. Cartographic information that does not change often (such as section lines, rivers, highways,
etc.) can be in read-only associated layers that only get loaded if the layer is made visible in the map. General
Copyright © IHS Inc. - 2012
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information about loading these data into the overlay is available in the PETRA overview class.

1.3

System Data Organization

PETRA DATABASE ENGINE
The PETRA database engine is a commercially available system, designed to be embedded in applications
such as PETRA. The benefits of using it in this type of application, over a more common relational database
engine from Oracle or Microsoft is its speed, flexibility, and robustness for an iterative, interactive workflow.
The database engine is actually stored on and runs from the "client" PC.
The database files are typically stored on a Windows network server, and that server is just acting as a file
server. This approach is different than the traditional (thin) client/ (fat) server structure. It takes advantage of
the distributed horsepower on individual PCs and at the same time reduces the demand on IT to provide a
single, extremely powerful (and costly) computer doing file serving AND all database searching for everyone
in the group.
Full record locking is provided by the PETRA database engines when more than one person is working in the
same project, and this record locking prevents any data collisions or corruption.
PROJECT "*.INI" FILES
When a new project is created, a project "ini" file is created to provide information to PETRA about where
the various data reside. These project files are named after the project, so a project named SAN JUAN
would have a "SAN JUAN.ini" file created that would contain the various paths to the private and public
PETRA and PetraSeis data. These project "ini" files are stored in a subdirectory called "PARMS" under the
local path (typically c:\geoplus1\parms). They are simple ASCII files and can be opened with a text editor,
such as Notepad. If the project "ini" file is not in the user's parms directory, the project will not show up when
they want to select a project from the list of existing projects.
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REGISTRY ENTRIES
Several operational parameters are included in the registry. Any parameter that needs to be customized for a
particular installation can be edited through a PETRA tool called config.exe. Therefore there should be no
reason to edit parameters directly through the Microsoft regedit.exe program.
PETRA.INI FILE
The petra.ini file is located in the server program directory and is used to control PETRA system wide
parameters, such as the tops user control, log in file parameters, etc. The parameters that are included in this
file are described in more detail later in this document.
GEOPLUS.INI FILE
The geoplus.ini file is located in the local program path (typically c:\geoplus1) and contains items about the
previous session information such as the current project name, window size, the list of the last 5 projects (for
the reopen list), some debug tools, etc. The content is managed by PETRA, so there should be no reason for
any external editing.
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2

Software Installation and Updates

2.1

Installation Overview

PETRA can be installed in either a network or standalone program configuration, but in this document we will
only describe the network seat (sometimes called a floating seat) process. There are three general components
to a PETRA network installation: the server software, the client software, and the license management. The
server software is where all the functionality of PETRA resides. The client is a small piece of software to link
to the server software and the data. The license management can be installed on the same file server or
another server, as long as the server is accessible by the client PCs.
The software for the initial installation is provided on a CD. For future installations or updates, go to http://
energy.ihs.ocm/Products.Petra.index.htm
and http://energy.ihs.com/Products/petraseis/support-petraseis/protected/petraseis-customer-download.htm
and download the latest versions of PETRA and PetraSeis, respectively.
The installation of these components is described below.

2.2

Installing PETRA Server Software

In a network installation, the PETRA executable files are installed on a network file server accessible to all
PETRA users. These files are installed using an installation program called "SERVER.EXE". The default
directory path is C:\PETRASRV and is referred to as the PETRA "system path." An example of a typical path
would be \\server1\petrasrv. It is important that users have read-write-create permissions to the "parms" and
"usermod" folders under this system path, since several template and data files are placed in the
"petrasrv\parms" folder and the "pertasrv\usermod" folder.

2.3

Installing PETRA Client Software

The PETRA client software is installed on individual PCs using a program called client.exe. The default
location for installation is on the local drive in the c:\geoplus1 subdirectory. The client software is very small
and rarely changes, since its primary role is to point to the location of the server software and to provide a
mechanism to define the type of license management used in the installation.
The PETRA database engine is also installed on the client PC as part of this process.
At the end of the client installation process, a configuration utility is automatically run to allow the installer to
define the desired paths and default settings. See the Configuring PETRA Client section immediately below for
details.

2.4

Configuring PETRA Client

A utility called config.exe is included in the PETRA client installation and is located in the same subdirectory as
the PETRA client software. It is automatically run as part of the client software installation, and can also be run
at a later date to change any of the parameters.
Copyright © IHS Inc. - 2012
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In the example above, the installer is indicating the server software has been installed on \\server1\petrasrv,
the client software is on c:\geoplus1, the default path for the public or shared part of the projects is \\server2
\geoplus\projects, and the default path for each individuals private parameters starts at \\server3\geoplus1
\users.
This example also shows using the NetHASP security device (bitlock) and searching the network to obtain a
license to run the software. This is the same configuration if you are using a network Flexlm license.

2.5

Installing PetraSeis Software

In a network installation, the PetraSeis executable files are installed in the same path as the PETRA software.
These files are installed using an installation program called "PSVer2.exe". An example of a typical path would
be \\server1\petrasrv. License management is similar to PETRA. See the Configuring PETRA client section of
the manual for details.

2.6

Typical Network Install Configuration

The following shows directory paths and contents of a typical network install of PETRA using the default
folder names.
On the SERVER
x:\petrasrv
< executables and dlls >
< petra.ini, nethasp.ini >
\Nethasp
< hasp license manager install files >
\parms
Copyright © IHS Inc. - 2012
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< data files copied to new projects >
< miscellaneous system data files >
\usermod
< log user model files >
On the CLIENT PC
c:\geoplus1
<geoplus.ini, config.exe, petra.exe, and other utilities>
\drivers
<HASP bitlock driver - hdd32.exe>
\parms
<INI files for each project the user can access
\projects
<local projects create by user>
\TUTORIAL (project)
PETRA projects can be located locally on the client or anywhere on a network. The "client" user can share
projects with any other PETRA user on the network.
The "client" user can access a PETRA license either from a network license manager or from a local "bitlock"
by using "config.exe" to configure licensing.

2.7

Typical Standalone Install Configuration

The following shows directory paths and contents of a typical standalone install of PETRA using the default
folder names.
c:\geoplus1
< executables and dlls >
< geoplus.ini, config.exe, petra.exe, and other utilities >
\drivers
< HASP bitlock driver - hdd32.exe >
\parms
< data files copied to new projects >
< miscellaneous system data files >
< INI files for each project the user can access >
\projects
< local projects create by user >
\TUTORIAL (project)
\usermod
< log user model files >
PETRA projects can be located locally or anywhere on a network. The standalone user can share projects
with any other PETRA user on the network.
The standalone user install can access a PETRA license either from a local "bitlock" or from a network license
manager using "config.exe" to configure licensing.
Copyright © IHS Inc. - 2012
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Installing NetHASP License Management

After installing the PETRA server software, use the NetHasp installation software (LMSetup.exe) located in
the \petrasrv\nethasp subdirectory.
To load the NetHasp License Manager on a Windows server as a service:
1. Log on as a user with Administrator Privileges.
2. Attach the NetHasp key to the LPT1 port or a USB slot on the server.
3. Run LMSetup.exe located in the \PetraSrv\NetHasp directory. Be sure to select the option that loads the
LM as a Service (i.e., Typical or Service).
4. Reboot the server or workstation to start the "Hasp Loader" service automatically. To keep the service
from displaying its data screen, click the "Startup…" button on the Services window, then disable the "Allow
Service to Interact with Desktop" option.
5. The ...PetraSrv\NetHasp directory contains a "skeleton" version of the NETHASP.INI file. You may need
to copy this file to the PetraSrv folder and modify it by uncommenting the appropriate network protocol. For
example, to force net hasp to only look at TCP/IP, uncomment or add a statement to the [NH_COMMON]
section that says; NH_TCPIP=Enabled
6. The default timeouts may be edited if PETRA users randomly get dropped from the application. A
NetHASP support representative suggested that the two following lines be edited:
;
; General Keywords.
;
;;NH_SESSION = <Num>
;;NH_SEND_RCV = <Num>
NH_SESSION = 20
NH_SEND_RCV = 10

; See Adapting the Timeout Length
; in the HASP Programmer's Guide.

7. To minimize traffic across the network when looking for a license, the NETHASP.INI file can list specific
IP addresses to be searched for available licenses. The format is:
;;NH_SERVER_ADDR = <Addr1>, <Addr2>
; IP addresses of all the NetHASP
; License Managers you want to search.
; Unlimited addresses and multiple
; lines are possible.
;
; Possible address format examples:
; IP address:
192.114.176.65
NH_TCPIP_METHOD = TCP
NH_USE_BROADCAST = Disabled

2.9

Installing FlexLM License Management

Instructions For A Site Currently Running Flexlm Applications
INSTALLING THE FLEXLM FILES
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Run the PETRA Flexlm installation program called PetraFlex.exe and install the files on the machine that runs
the Flexlm license manager. The default folder is c:\petraflexlm.
OBTAINING A LICENSE FILE
After installing the Flexlm files you must run a small utility to display the "host id" of the PC that will be running
the FLEXlm license manager.
Run c:\petraflexlm\flexhostid.exe or use Flexlm's lmtools.exe manager program, "System Settings" tab to get
the host name and host id of the license manager machine. Communicate this information via email or phone
to PETRA technical support to receive a valid license file for your site. The name of the license file will be ihs.
lic.
ADDING THE IHS DAEMON AND LICENSE FILE
Copy c:\petraflexlm\ihs.exe to the folder where Flexlm's lmgrd.exe license manager application is installed.
Copy ihs.lic (the license file you receive from PETRA technical support after running flexhostid) to the
common license directory configured for the existing FLEXlm installation. Optionally, refer to the FLEXlm
End Users Guide, "Managing Licenses from Multiple Vendors" chapter for options such as merging multiple
vendor license files or running separate license managers on one machine.
Restart the FLEXlm server or service to read the new ihs.lic license file and start the new ihs.exe vendor
license manager program. Use lmtools.exe, "Server Status" tab, "Perform Status Enquiry" to verify the license
manager started and the number of licenses for the features you have purchased are available for use.
Proceed to "Configure Petra For Flexlm".
Instructions for a site not currently running FLEXlm applications
Choose a machine to be the license manager whose TCP / IP address is visible and reachable over the
network by all client workstations. This is normally a central file server or a machine dedicated to license
management.
INSTALLING THE FLEXLM FILES
Run the Petra Flexlm installation program called PetraFlex.exe and install the files on the machine that will run
the Flexlm license manager. By default, the install folder will be c:\petraflexlm. If these files are to be installed
on a remote drive, make sure the drive is accessible to the machine at boot up before the operating system
services are started.
Run c:\petraflexlm\lmtools.exe from the license manager machine.
Select the "Service / License File" tab. Verify "Configuration using services" is selected.
Select the "System Settings" tab. Click on "Save HOSTID info to a file" and save the file as "Hostid.txt"
without the quotes to the c:\petraflexlm folder. Communicate this information via email or phone to PETRA
technical support to receive a valid license file for your site. The name of the license file will be ihs.lic. Copy
the ihs.lic file you receive from PETRA technical support to the c:\petraflexlm folder, i.e., where ihs.exe is
located.
Copyright © IHS Inc. - 2012
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Select the "Config Services" tab. Type "GeoPLUS License Manager" as the "Service Name." Click on the
first "Browse" button. Locate and select the lmgrd.exe file. Click on the next "Browse" button. Locate and
select the ihs.lic file. Optionally, click on the final "Browse" button, choose a folder with a good amount of
free space and create a log file named "ihs.log" to record license activity and for debugging license server
problems. Select the "Use Services" check box. Select the "Start server at power up" check box. Finally,
click on the "Save Service" button.
Select the "Start / Stop / Reread" tab. Make sure "GeoPLUS License Manager" is highlighted. Click on the
"Start Server" button. Verify "Server Start Successful" appears in the status box at the bottom of the screen.
The license manager service is now running and ready to manage licenses.
Finally, select the "Server Status" tab and click the "Perform Status Enquiry" button to view the current status
of the license manager service and see the user name / machine name of users who are currently issued
licenses. Use the "Edit" menu, "Clear Window" command to clear the information between status checks.
NOTE - The ihs.log file may be viewed with Notepad, WordPad or Word to view license activity. The
lmtools.exe "Config Services" tab also has buttons to "View Log" to view the contents of the log file and
"Close Log" to close the viewing window.
Proceed to "Configure Petra For Flexlm".
CONFIGURE PETRA FOR FLEXLM
( See "Creating a New PETRA.INI File" for additional information )
After installing the Flexlm license manager and the ihs.exe and ihs.lic files, you must instruct Petra to look for a
network Flexlm license instead of a network bitlock. This is done by adding two statements to the PETRA.
INI file. PETRA.INI is located in the Petra program folder (typically c:\petrasrv). If you currently do not have
a PETRA.INI file you can copy the one from the c:\petraflexlm folder from the previous steps. The PETRA.
INI file requires two statements under the [NETLOGIN] section as shown in the following example:
[NETLOGIN]
FLEXLM=ENABLED
FLEXLMLICPATH=27000@hostname

If you have purchased PETRA "Data Access" licenses, you will need to include an extra line as follows:
[NETLOGIN]
FLEXLM=ENABLED
FLEXLMLICPATH=27000@hostname
FLEXLMDATALIC=YES

If you have multiple Flexlm servers that you want to obtain licenses from, you can have multiple license path
records as follows:
[NETLOGIN]
FLEXLM=ENABLED
FLEXLMLICPATH=27000@hostname
FLEXLMLICPATH1=27000@hostname_a
FLEXLMLICPATH2=27000@hostname_b
Copyright © IHS Inc. - 2012
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FLEXLMLICPATH3=27000@hostname_c

In the above examples, the "hostname" should be replaced with the machine name of the computer running the
Flexlm license manager. Using IP addresses normally results in faster license acquisition. "27000" is a default
port number.
(Optional)
In addition to the PETRA.INI changes, the client's workstation must be configured to use a network license. If
you have already been using a network bitlock licensing mechanism, such as Net HASP, then the client's PC is
already configured correctly and there is nothing else to do. Use the c:\geoplus1\config.exe on the client
workstation for this purpose.
BORROWING LICENSES FOR TEMPORARY, REMOTE USAGE
Your PETRA FlexLm license file may authorize license borrowing on a temporary basis. That is, a network
license may be borrowed or checked out for remote usage. PETRA allows licenses to be borrowed for up to
30 days.
PETRA has a special utility program for borrowing licenses. This program is called PetraBorrow.exe and is
installed with the other PETRA Flexlm files.
The Flexlm license manager will automatically free a borrowed license after it expires on the workstation.
FLEXLM ENVIRONMENT VARIABLES
One issue that can effect PETRA's ability to obtain a Flexlm license is the use of environment variables by
other vendors using the same flexlm license manager. PETRA does not use or require such environment
variables, however, some other applications do. These environment variables can redirect the flexlm license
manager to a specific license file which would not contain the PETRA license information. PETRA would not
be able to obtain a license.
The solution is the remove the environment variables or add the vendor-specific license information to the
appropriate license file.
The Flexlm licensing software provided by Macromedia will attempt to override Petra's ini settings using
client-side environment variables. Flexlm uses two methods to resolve license information from environment
variables.
First is the generic variable called LM_LICENSE_FILE.
The second is avariable named using the vendor's name, ie, VENDOR_LICENSE_FILE, where "VENDOR"
is replaced with the actual name that matches the daemon name, such as, XYZSOFT_LICENSE_FILE.
IT IS NOT RECOMMENDED to use a IHS_LICENSE_FILE variable to resolve conflicts.
IT IS RECOMMENDED that you add the other vendor's license file variable to resolve conflicts.
DO NOT USE the generic LM_LICENSE_FILE variable.
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Another issue that can affect Petra’s ability to obtain a Flexlm license is the FLEXLM_TIMEOUT
environment variable. This variable controls the timeout value for the license request to the license server.
If the users are experiencing license request failures when they start Petra for the first time after logging into
their machine, but are able to start Petra successfully afterwards, then this value may need to be increased.
The value is specified in microseconds (millionths of a second). The default value is 100000 (100 milliseconds,
or 1/10 second). On slower networks this value will need to be increased. A value such as 5000000 (5
seconds) should be sufficient.

2.10

Migrating to Citrix

PETRA now has limited support of Citrix for customers who want to migrate PETRA network licenses to the
Citrix environment. The requirements are:
PETRA network licenses are being used, rather than PETRA standalone licenses.
PETRA is already installed in a networked environment and projects are already being shared by multiple
user's.
The PETRA private parameters are grouped in a common structure, based on user names as part of the path
(i.e. \\server1\users\%username%\geoplus1).
Citrix Access Suite 4.0 or later is being used, and your organization is familiar with publishing applications in
that environment.
Windows Server 2003 or later is being used for the terminal server and all the latest patches have been
applied.
Before starting the installation of PETRA:
1.
Make sure Citrix is installed and the version is Access Suite 4.0 or greater and that all updates have
been applied.
2.
Make sure that the resolution for the client machines is set high enough for PETRA. For example:
1024X768 True Color (24Bit).
3.
Make sure that the Windows Server Operating System is current with the latest Windows updates
and Service Packs applied.
4.
Search http://technet.microsoft.com/ for "enabling users to connect remotely" to read an article
describing how to enable users to connect remotely to a terminal server. Add the PETRA users to "Remote
Desktop Users" group.
To install PETRA for Citrix:
Login as Administrator or with an ID that has administrative privileges to register PETRA.
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Install the PETRA server software on the Citrix server, as described in the "Installing PETRA Server
Software" portion of this document.
Install the "client.exe" for PETRA in the same folder where the server software is installed (typically called
the \Petrasrv folder). NOTE: the standard instructions are for installing the PETRA Client on an individual
workstation. Client installation on each workstation is not necessary for Citrix as each client will run in
separate sessions on the server.
During installation of the PETRA client, a "PETRA Workstation Network Configuration Program" dialog
screen is displayed, as shown below. Enter the path to where PETRA was installed on the server, in the
(System Path) data entry field.

Enter the generic path to where the user's have their private parameters, in the (Client Path) data entry field.
Use the %username% environment variable in the path to keep each user's private parms in separate folders.
Enter the path where shared or public projects are to be created on the network in the (Project Path) data
entry field.
For installations using a hardware bitlock, select the appropriate key type in the "Security Key Type" section.
Check your PETRA network bitlock for confirmation of the type. The "Red" key and the USB keys are
"NetHASP". The Beige key is a "Rainbow NetC" key. If you are using FlexLM for PETRA license
management, just go to the next step.
Verify the "Network Server" option is checked in the "Obtain PETRA License From" section, and then click
on "OK" to save.
Enable Sharing of PETRA software with Remote Users
Right click on the Petrasrv folder, select the "sharing and security..." option and change the share name to
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Petrasrv. Under the Permissions tab, add "Remote Desktop Users" group to the "Group or user names"
section and give this group "Read and Change" permissions.
Now, follow the Citrix instructions to publish PETRA as an application.

2.11

Remote Access with Standalone License

It is possible to use a single user, "stand alone" bitlock in a remote access configuration under the following
conditions:
1) The remote "host" can not be a server. It must be a "workstation" such as XP Pro.
2) There can be only one connection to the host when Petra attempts to obtain a license.
3) If you have a Hasp (memo hasp) bitlock, you must have already logged on at the host (not remotely). Then,
from the remote PC you can "logon" to connect. Then you must "disconnect" from the host when you are
done. Do NOT "logoff" from the host, else you will have to drive to your office and logon again.
4) Condition #3 is not required if you have one of the older technology Rainbow bitlocks. You may logon and
logoff remotely using the Rainbow bitlock.

2.12

Installing the ArcMap Extension

General:
The ArcMap extension is a menu tool added to ESRI's ArcMap product that allows data exchange with a
PETRA project.
Requirements:
PETRA "ESRI" License(s) using FlexLM for Windows license management
ESRI ArcMap 9.1 or newer
Summary:
After verifying the above requirements are met, there are two steps to install the software.
1. Install and register the PETRA DB Server
2. Install the ArcMap Extension (also known as the PETRA ESRI Toolbar) into ArcMap
Installation of the PETRA DB Server Software:
(Automatic Registration)
Beginning with PETRA Version 3.1.8.5 (November, 2006), there is a new menu item in the PETRA main
module under Project > Settings > Register PetraDBServer for ESRI Plug-in to automatically register the
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components in the PC Registry. The user needs to have Administrative rights to be able to register the
components. If you have an older version of PETRA and don't see this menu item, proceed to the Alternate
Installation Instruction section below.
Alternate PETRA DB Server Installation Instructions.
(Manual Registration)
These steps are to be used if you are using a version of PETRA prior to Version 3.1.8.5 or if PETRA is not
installed on the PC.
PetraDBServer.exe and PetraESRI.dll are to be physically copied to the Petra installation folder.
PetraDBServer must be with the rest of the Petra software so it can access Petra's data libraries ( *.dll ). In
networked installations, the folder is typically \\servername\petrasrv. In standalone installations, the folder is
typically c:\geoplus1.
PetraDBServer.exe must then be run ( executed ) at least once from the workstation where ArcMap is run,
and not on the server. Running the executable on the workstation where ArcMap is used registers the COM
components in Windows so ArcMap can use those components to access Petra's libraries. There will be no
indication that it is running. Run the task manager to kill the PetraDBServer task, or reboot the workstation.
NOTE: The user who is logged into Windows must have administrator rights or at least the rights to install
software and register COM objects in Windows. This user can also run RegEdit and search for the
PetraDBServer namespace in the registry. Components such as PetraDB, Overlay, Workgroups, Zone,
Location, Well, etc... should be registered under this namespace, if the install was successful.
Installation of the PETRA Toolbar in ArcMap:
To add this toolbar to ArcMap, start ArcMap and click on "Tools > Customize". Click on the button to "Add
from file" and browse to and select the PetraESRI.dll file. Then go to "Tools > Customize" and check the box
next to the word "PETRA". The toolbar added to ArcMap will then be able to access Petra data using these
components. If Petra can open the project and access the data in Main, then the ArcMap toolbar can open
the project and access the data.

Copyright © IHS Inc. - 2012

Software Updates

3

Software Updates

3.1

Force Shutdown of PETRA
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Before updating PETRA, it is necessary to shut it down so all pertinent program files are available. Many times
the update is done after hours and there may be some PETRA sessions still active with project files open. The
following procedure is available if it becomes necessary to shut down all PETRA users and have them get out
of PETRA:
Place a file called "NOTIFYKILL.RTF" in the PetraSrv folder (typically \\server1\petrasrv).
Alternatively, you can place the "notify kill" file in the root folder of a particular project to shut down users in
that project only.
There is a default file called XNOTIFYKILL.RTF already available. It is in a rich text format (rtf) and can be
customized for your environment. Just rename the file to NOTIFYKILL.RTF when you are ready to initiate
the shutdown.

Within 5 minutes, all PETRA users will be notified of the impending shutdown and told their data will be saved
(via the NOTIFYKILL message). Wait 10-15 minutes before proceeding with maintenance duties in order
that all users have had time to exit after automatically saving data. Some overlay files may take several minutes
to write to disk.
To allow users back into PETRA, rename NOTIFYKILL.RTF back to XNOTIFYKILL.RTF.
The following modules save data in the Private Parms folder using a time stamped (xxxxx) file
name:
Map - Overlay File
Map - Control Pt File
Map - Production Patterns
Map - Posted Data Offsets
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Cross section - Overlay File
Production Analysis – Settings

XSOVERLAY_xxxxx.XSO
PASETTINGS_xxxxx.

The following optional PETRA.INI file variables apply to the kill notification:
[NOTICE]
KILLWAITSEC=10
KILLSOUND1=<wave file>
KILLSOUND2=<wave file>
KILLSOUND3=<wave file>

Seconds to display user notice before closing
Sound file to play when notice appears
Sound file to play once per second
Sound file to play when removing notice

If the above "KILL" controls are not placed in the PETRA.INI file, the default values are 10 seconds notice
before the shutdown begins and some common sounds for each of the three sounds( an "uh-oh" sound, a
"ding" sound, and a ??? sound).

3.2

Updating Software

The client software (installed on each geoscientists' PC) rarely changes. In fact it has only changed 3 or 4
times since 1997. However, a new version of PETRA (as part of the server software) is routinely uploaded
every 3 to 4 weeks. Because of the way PETRA is packaged, it is easy to update everyone in the organization
with less than 10 minutes effort. (In general it takes more effort to get everyone out of PETRA, than to do the
actual update).
PETRA updates periodically contain changes and additions to the database tables. If an updated version of
PETRA is used to access a shared project, older versions of PETRA may no longer be able to access that
project. All PETRA seats within an organization should be updated at the same time. If the organization
prefers to test new versions of PETRA before general release to all users, it is best that testing be done with
dedicated testing projects rather than projects that the organization wishes still be accessible to older versions
of PETRA.
To perform a PETRA update, download the latest version server.exe from http://energy.ihs.com/products/
petra/support/protected/petra-customer-support.htm, make sure no one is running PETRA (see "Force
Shutdown of PETRA" section), start server.exe and reinstall PETRA in the same directory as before.
To perform a PetraSeis update, download PSVer2.exe from http://energy.ihs.com/Products/petraseis/
support-petraseis/protected/petraseis-customer-download.htm, make sure no one is running PETRA or
PetraSeis (see "Force Shutdown of PETRA" section), start PSVer2.exe and reinstall PetraSeis in the same
directory that contains PETRA. NOTE: When updating PetraSeis, it is highly recommended that PETRA be
updated immediately before, since PetraSeis shares many of the libraries and functions in PETRA.
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Placement of Projects

4.1

Defining Workgroups
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The default setting in PETRA is to allow the end user full control of where new projects are stored within their
network. In large companies, there can be several business groups using PETRA and therefore a desire to
group the location of projects by business unit. For example the Anadarko Basin folks should store their
projects on "server1" and the Western Canadian group should store their projects on "server3".
PETRA provides an optional way for an administrator to restrict where new projects are placed. There is a
utility to then report various project metrics (such as disk space used, number of wells, etc.) for each of the
workgroups or business units. The first step is to create a workgroup definition file (workgroup.def) with one
line for each of the desired business units. Each line contains the name of the business unit, a path name for the
public dataset, and optionally, a path name for the private dataset. The format for this file is:
"Anadarko Basin", "\\server1\Anadarko\projects" , "\\server1\Anadarko\users"
"Permian Basin","\\server2\Permian\projects" , "\\server2\Permian\users"
"Western Canada","\\server3\WCanada\projects" , "\\server1\WCanada\users"
The workgroup.def file must reside in the same directory where the PETRA software resides (typically \
\servername\petrasrv ). The utility program, PetraProjectReport.exe must be inserted in the PETRA software
directory, as well.

4.2

Creating a New Project

As new projects are created, the work group definition file is used by PETRA to control the physical
placement of the project data files.

After indicating a new project is to be created, and whether it is to be shared with other team members, a new
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dialog box is displayed by PETRA to allow the user to point to the desired group, and therefore where the
project should be created.

In this example the project path is displayed as a local drive (c:\geoplus1\projects), but it could also be a URL
(uniform resource locator) style as shown in the workgroup.def example above. If the optional path for storing
a user's private data has been defined in workgroup.def, then there will be a similar display for pointing to the
desired path for the user private data.

4.3

Connecting to an Existing Project

Connecting to an existing project (to share with other team members) uses the same process as before.

However, it is much easier, because the user just points at the (predefined) name of the group and desired
project name in order to be connected to the public portion of the project.
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The next step is to point at the directory where the user files have been set up as part of the overall layout. The
result is that PETRA will link the user to the public data and create the necessary private tables (for "look and
feel" and user templates).

4.4

Workgroup Reporting Tool

A utility called PetraProject Report.exe will easily generate reports summarizing the "metadata" of the projects
(project name, description, size, Lat/Lon limits, creator, who last accessed a project and when, and number of
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wells), based on the workgroup paths defined in the workgroup.def file. After copying PetraProjectReport.
exe into the PETRA software directory (typically \\servername\petrasrv), run it to generate the following
displays.

The second screen shows a 3D pie chart of the project within the specified workgroup and their relative sizes.

The third screen shows a bar chart of the 15 largest projects.
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OUTPUT FILES
This reporting tool exports a comma separated variable (csv) file with the project data displayed in the first
screen, and a shape file with the projects extents. All of the fields displayed on the data screen above are
included in the shape file. The sample shape file shown below has the labels for project name, date last
accessed, and the number of wells.
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5

The PETRA.INI File

5.1

Overview

The PETRA.INI file can be used to control "global" configurations for all Petra users.
The PETRA.INI file is placed in the Petra "system" folder, normally this is PetraSrv

5.2

Creating a New PETRA.INI File

The PETRA.INI file must reside in the folder where the PETRA executables are located. If the defaults were
taken at insall time, this would be the PETRASRV folder.
PETRA.INI is not created automatically, but must be created manually, either from scratch, or by copying the
sample provided by the install procedure.
The sample PETRA.INI file is located in the PETRASRV\PARMS folder. Copy this file to the PETRASRV
folder and edit it using "Notepad" or "WordPad".

5.3

GENERAL Section

The [GENERAL] section contains the following parameters:
SHOWWEBSITE=NO
Add this statement to hide the IHS web link from the main "help" menu.
NOTIFY=NO
Add this statement to hide the license expire messages during startup. This could be useful when using a
temporary license or you don't want the users to know your maintenance is about to expire.
MJDELAYSEC=seconds
Add this statement to increase the amount of time Petra waits and retries to receive direct connected raster
logs from MJ LogSleuth.
ADMINPSWD=password
Add this statement so an administator can open a password protected project. Replace the "password" with
the appropriate text used as the overridding project password.
LICUNCNAMES=YES
Add this statement to force Petra to use UNC names when accessing images (logs and maps). When a user
saves a raster calibration file, all filename references will use the UNC path name in place of the drive letter
mapping.
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The next 2 entries allow Petra to launch a user-supplied application and pass the selected well UWI
to it.
USERAPPLNAME=name
Name of application to appear in Petra's menu (30char max)
(e.g., Company Document Manager)
USERAPPLPATH=path
Fully qualified directory path and filename of the executable program.
Petra will launch this program and pass the well UWI as a single run-time parameter.
(e.g., \\geoapps\welldocs\software\mgr.exe)
NOTE - The above 2 parameters can also be specified in the client "geoplus.ini" [STARTUP] section as a
local override to the system (petra.ini) setting.
MODIFYPLACESBAR=NO
Add this statement to prevent Petra from modifying the "Places Bar" in the user's registry. By default, Petra
will modify HKEY_CURRENT_USER entries to add various Petra project paths to the Open and Save
Dialog places bar.
(default=YES)
BINGMAP=NO
Use this option to disable Bing satellite imagery maps in the main and map modules. This option replaces the
GOOGLEMAP option.
(default=YES, enable Bing)
BING_WGS84_DATUMSHIFT=NO
Use this to disable PETRA from converting lat-lons to WGS84 before sending them to Bing. This option
replaces the GOOGLE_WGS84_DATUMSHIFT option.
(default=YES, perform conversions)
CLIPBOARD_WGS84_DATUMSHIFT=NO
Use this to disable PETRA from converting lat-lons to WGS84 before copying them to the clipboard when
using the map's "Copy Location Lan/Lon to Clipboard" context menu option.
(default=YES, perform conversions)
The next 2 entries allow control of map projection options.
SAVEDEFAULTPROJECTION=NO
Add this statement to prevent any user from creating a system-wide default projection file. The default
projection file is kept in the system parms folder (petrasrv\parms) as either DEFPROJECTION.BIN or
DEFPROJECTION1.BIN.
These files can be deleted if you wish.
ALLOWUSERPROJECTION=NO
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Add this statement to prevent users from creating user-defined coordinate systems under the "standard" tab.
BKGNDSCAN=YES
Add this statement to have PETRA scan your project well locations to compile the lat-lon extents of the
project. These limits are then stored in the project ini file (in the project directory).
BKGNDSCANTIME=integer
This sets the amount of time (in minutes) PETRA waits between scans of the project extents (see
BKGNDSCAN above). Leaving this statement out causes PETRA to default to a 30 minute interval.
SKIPUPDATECHECK=YES
Setting this switch will skip the version update check. To enable update checking set
SKIPUPDATECHECK=NO. Individual user control of this option is obtained by adding
SKIPUPDATECHECK=(0 or 1) to the [STARTUP] section of the users geoplus.ini file.
AllowPrivateMode=NO
Enables or disables the ability for users to use Private Mode in Petra v4 and above.
(default=YES)
HideLoginDialog=YES
If enabled (YES), then the initial mode selection/login dialog when Petra is opened will not be displayed. In
this instance, Petra will automatically use the last mode/user login information that was used.
(default=NO, introduced in Petra v4.0.6)
UserPrivateParmsPath=path
The following variables can be used within the specification of the "path":
#UserName#, #ProjectPath#, #ProjectName#
If used, this option forces the location of each users private path based on the "path" entered (please see input
variables above). This change affects creating new projects, opening a project which a user has not previously
connected to, and re-migrating Private Parameters from v3.
(default is off, introduced in Petra v4.0.8 - SampleEntry:
"UserPrivateParmsPath=#ProjectPath#\UserParms\#UserName#")
PriParmsMigrationPrompt=NO
If NO, users will not automatically be prompted to migrate private parameters from v3 when opening a
project which they have not previously connected to.
(default=YES, introduced in Petra v4.0.8)

5.4

USERSOURCE Section

IMPORTANT - These settings may be placed in a copy of the PETRA.INI located in each project's
root folder and will override the settings from the system PETRA.INI file. Normally, there is no
PETRA.INI file in the project root folder, so one will have to be created.
The [USERSOURCE] section provides restriction of data by source. In addition to limiting changes to other
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users' data, such as tops, based on source code, Petra limits the following functions to users set up as
administrators:
Deleting Wells
Making Global Datum Changes
Performing Global Data Deletion
Modifying the Map Projection
The following USERSOURCE parameters are available:
ENABLED=0 or 1
When set to 1, all Petra projects will use the source code restriction mechanism. This will restrict users to
being able to only edit their own formation tops. Upon starting Petra, they will be prompted for their initials or
source code. All tops they create will use this source. They will be prevented from modifying tops with other
source codes.
BLANKS=0 or 1
0 means no one can modify a top if it has a blank source code (except administrators).
1 means everyone can modify a top if it has a blank source code.
ADMINLIST=aaa,bbb,ccc, ... etc
This is a list of source codes for those users that have the right to modify any Fm Top regardless of the
source.
EXAMPLE:
[USERSOURCE]
;
; lines beginning with a semicolon are comments
;
ENABLED=1
BLANKS=1
ADMINLIST=hlm,tdw,bob
In the above example, the USERSOURCE control mode has been enabled and three people, hlm, tdw, and
bob are designated as administrators. Therefore, hlm is able to update tops for anyone in the group, but Sam,
who is not an administrator, can only create and update his own tops. With "BLANKS" enabled
(BLANKS=1), anyone can change a top that has a blank source code.

5.5

LOGARC Section

The [LOGARC] section contains the following configuration parameters for LogTech software. Petra can
interface with the LogArc software to retrieve logs from a LogArc database.
PROGRAM=fullpath\LOGarcve.exe
This is the program path where the logarc retrieve executable resides if it can not be determined from the
user's registry.
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NOTICE Section

The [NOTICE] section contains configuration parameters when using the "Notification Page" (see Posting a
Notice Page)
BACKCOLOR=r,g,b
Set the r, g, and b values to a number from 0 to 255 to represent an RGB color value for background screen
color of the notification page.
SOUNDFILE=filename.wav
Play this "wave" sound file when the notice is first displayed
The following parameters apply to the "Kill Notify" feature (see Force Shutdown of a Project)
KILLWAITSEC=seconds
Set the number of seconds the Kill Notify Screen will display until the user clicks Close.
KILLSOUND1=filename.wav
Play this "wave" sound file when the kill notify message is first displayed.
KILLSOUND2=filename.wav
Play this "wave" sound file while the kill notify message counts down to 0.
KILLSOUND2=filename.wav
Play this "wave" sound file when the kill notify message closes.
The following parameters apply to the "User Broadcast Notification" feature
UBCBACKCOLOR=r,g,b
Set the r, g, and b values to a number from 0 to 255 to represent an RGB color value for background screen
color of the notification page.
Default is white background color
UBCWAITSEC=seconds
Set the number of seconds the User Notify Screen will display until the user clicks Close.
Default is 10 seconds.
UBCSOUND1=filename.wav
Play this "wave" sound file when the User Notify Screen is first displayed. Set to "NONE" for no sound.
Default = SND8.WAV
UBCSOUND2=filename.wav
Play this "wave" sound file while the User Notify Screen counts down to 0. Set to "NONE" for no sound.
Default = SND8.WAV
UBCSOUND3=filename.wav
Play this "wave" sound file when the User Notify Screen closes. Set to "NONE" for no sound.
Default = SND5.WAV
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NETLOGIN Section

The [NETLOGIN] section contains parameters pertaining to obtaining a network license.
IMPORTANT
Additional information can be found in the section entitled "Software Installation and Updates"
LogFileName=pathname
Set the path and file name of a file that can be written to whenever user open/close projects. Users must have
full read/write access to this file. This file can be used to determine when users are denied licenses.
LogProjectAccess=YES
Include this parameter to have the "userlog.ini" updated with information each time a user opens or closes a
project. This log file will be located in the root of the project folder.
SysProjectLog=YES
Include this parameter to have the the master "userlog.ini" updated with information each time a user opens
or closes a project. This log file will be located in the system parms folder, normally PetraSrv\Parms.
NOTE - This option requires LogProjectAccess=YES
The following parameters apply to the "FLEXLM" license feature
FLEXLM=ENABLED
Must be set to allow use of a Flexlm license.
FLEXLMLICPATH=port@server
Specify the port and server where the flexlm license manager is located. An example might be:
27000@DAVIDXP64
FLEXLMDATALIC=YES
Use this parameter when you have purchased Petra "Data Access" licenses and want to use data transfer
purposes. Without this parameter, a Petra license is be used for data transfer.

5.8

IMPORT Section

The [IMPORT] section allows default pathnames for importing certain data types:
LASPATH=foldername
Sets the folder name of the default folder when importing LAS log curve files.
RASTERPATH=foldername
Sets the folder name of the default folder when importing the various raster log calibration files.
The following entries define the catalog setting distributed with IHS (US) raster logs
IHSLOGNDXROOTFOLDER=foldername
Sets the folder name of the "root" folder, below which reside the IHS directory structure containing the LIC
and TIF files.
For example, say you received folder of logs from IHS called IHS_ENERY, beneath which are many
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subfolders of rasters and LICs. You might create a folder on your network called, H:\LOGDATA and copy
the IHS_ENERGY folder beneath it. So your logs are: H:\LOGDATA\IHS_ENERGY\Rocky
Mountains\Colorado\ . . .
Set IHSLOGNDXROOTFOLDER=H:\LOGDATA
IHSLOGNDXDBFOLDER=foldername
Sets the folder name containing the IHS catalog database files (tblLogs.dat and tblLogs.idx)
In the above example, you might have to set
IHSLOGNDXDBFOLDER=H:\LOGDATA\IHS_ENERGY\Rock Mountains\database\
The following entries define the raster log catalog created from "LICCat.exe"
LICCATALOG=catalogtablename
Sets the path and name of the catalog database file created by LICCat.exe. This is the DBIsam database file
without an extention. This catalog can be used for batch import of LIC files.

5.9

MAPTEXT Section

The MAPTEXT section allows an administrator to force a message to be printed at the bottom of each map
produced by PETRA. An example would be if you wanted all maps generated by your company to display a
copyright or disclaimer message at the bottom. Up to 5 lines of text can be plotted and are positioned just
above the map border. The text can be positioned at the left side, center (default position), or right side of the
map. The text height can also be specified in inches. The default text height is 0.065 inches.
MAPTEXT Parameters:
TEXTHT = text height in inches. Default is 0.065 inches
POSITION = Relative position of text along bottom of map. Values can be LEFT, CENTER, or RIGHT.
Default value is CENTER.
LINE1 through LINE5 = Text lines to plot.
The following is an example of the map text ini parameters:
[MAPTEXT]
TEXTHT=0.1
POSITION=LEFT
LINE1=Property of XYZ Oil & Gas Company
LINE2=Copyright 2006
LINE3=All Rights Reserved

5.10

ENERDEQ Section

The ENERDEQ section allows an administrator to set company-wide settings to control Petra's access to the
US IHS "Direct Connect" feature.
Normally, these parameters are only required for INTRANET installs of the data server or if your company
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has a proprietary version of the IHS databases.
ENERDEQ Parameters:
URL = inter/intranet address of the IHS Web Services (WS) server.
Default value is handle by the Petra software.
The following is an example of the parameters:
[ENERDEQ]
url=https://webservices1-2.ihsenergy.com/WebServices

5.11

IHSCAN Section

The IHSCAN section allows an administrator to set company-wide settings to control Petra's access to the
CANADIAN IHS "Direct Connect" features.
Normally, these parameters are not required to be entered. They are only necessary to override the default
settings and behavior.
IHSCAN Parameters:
WELLSERVER = Server address of the Canadian IHS well data server
Default value is handle by the Petra software.
WELLPORT = Port address on the Canadian IHS well data server
Default value is handle by the Petra software.
SERVER = Server address of the Canadian IHS log data server
Default value is handle by the Petra software.
PORT = Port address on the Canadian IHS log data server
Default value is handle by the Petra software.
HIST22 = Switch to use well location types based on the historical 2.2 grid or location types based on
province.
In NAD27 only, download historical well locations based on the ATS2.2 grid. By default
(HIST22=NO or not entered) PETRA downloads the most recent well locations based on the
ATS2.6 grid for Alberta, the BC2.0 grid for British Columbia, the MLI07 grid for Manitoba, and
the STS25 grid for Saskatchewan.
In NAD83, well locations are only available in BCTS20 for British Columbia, MST0305 for
Alberta, MTS10 for Manitoba and STS25 for Saskatchewan. The HIST22 parameter does not
apply for projects in NAD83.
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The HIST22 setting will be reported at the top of all log files for Canadian Direct Connect well
data downloads.
Default value is FALSE.
Valid values are TRUE/FALSE/ON/OFF/1/0.
The following is an example of the
parameters:
[IHSCAN]
WELLSERVER=petra.ihsenergy.com
WELLPORT=5557
SERVER=dlp001.ihs.internal.corp
PORT=9503
HIST22=TRUE

5.12

WMS Section

The WMS section allows an administrator to set company-wide settings to control PETRA's access to WMS
(Web Map Service) Imagery features.
WMS Parameters:
url#= URL address of the WMS service.
description#= (Optional Description of the service)
user#= (Optional Username not required for most services)
password#= (Optional Password not required for most services)
The # symbol is a numerical value and must be the same for each associated entry. The petra.ini file can have
a list of url's to choose from in the [WMS] section. Typically this will be set by a local admin that can supply
all users with a predefined list of WMS servers available to them. Each url can be thought of as part of a
"group". Each url "group" can have up to 4 associated keyword/value pairs. The "url" which is the http address
of the WMS server, the "user" which is required only if authentication is needed for the WMS server, the
"password" which is required only for authentication also, and the "description" which can be up to 256
characters and describes the WMS server. Each url "group" has an associated number with it, such that all
keywords having that number belong to the same "group", such as url1/user1/password1/description1, url5/
user5/password5/description5, or url10/description10. The only required keyword is "url" with it's associated
group number. The only requirement for each group's number is that it is unique to that group, it does not need
to start at 1 and increment by 1. The group's keyword/value pairs also don't need to be located in any
particular order in the file itself, i.e., all the url's can be listed then all the descriptions, or each url can have it's
description following it on the next line.
Example:
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[WMS]
url1=http://www.server.xyz1
user1=username
password1=password
description1=Description for url1
url2=http://www.server.xyz2
url3=http://www.server.xyz3
url4=http://www.server.xyz4
description3=Description for url3
description2=Description for url2

5.13

DEFAULT Section

The DEFAULT section allows an administrator to set company-wide settings to control PETRA default
settings. These parameters are not required to be entered.
DEFAULT Parameters:
MAP_DIRSURVENABLE=TRUE or FALSE
Allows administrator to set default behavior of Map Module > Wells > Directional Survey > Enable switch.
MAP_OVLYAUTOSAVEMINS=(Number of minutes)
Allows administrator to set number of minutes between overlay autosaves.
MAP_OVLYAUTOSAVELVLS=(Number of saved overlays to keep)
Allows administrator to set number of saved overlays to keep as backups during overlay autosave process.
MAP_GRIDDIR=(Full path to grid folder)
Allows administrator to set grid default folder.
These settings may require a reset of the Map Module (Main Module > Project > Settings > Reset Module)
before they will take effect in existing projects.
Example:
[DEFAULT]
MAP_DIRSURVENABLE=FALSE
MAP_OVLYAUTOSAVEMINS=60
MAP_OVLYAUTOSAVELVLS=1
MAP_GRIDDIR=c:\geoplus1\datanewgrid

5.14

HTTP Section

The HTTP section allows an administrator to set company-wide settings for accessing the internet. These
parameters are not required to be entered.
HTTP Parameters:
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ConnectTimeout=(number of msec).
Optional timeout when connecting in msec. Default is 60,000.
SendTimeout=(number of msec)
Optional timeout when sending request in msec. Default is 30,000.
ReceiveTimeout=(number of msec)
Optional timeout when receiving response in msec. Default is 30,000.
Example:
[HTTP]
ConnectTimeout=120000
SendTimeout=60000
ReceiveTimeout=60000
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Posting a Notice Page

6.1

Creating a Notice Page
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PETRA administrators have the option to define a simple notice page which will be automatically displayed
each time someone starts PETRA. Also, a "notify" file can be placed in the root folder of a project to display a
notice whenever users open the project.
The file must be a rich text format file with the name of notify.rtf and the file must be stored in the
subdirectory where PETRA resides (typically \\server\petrasrv for network users and c:\geoplus1 for
standalone licenses). A project-specific file is placed in the root folder of the project. These rtf files can be
created and edited by MS Word and MS Wordpad, among other text editors. An example of this file follows.

The color of the text is defined in the rtf document, as determined by the capabilities of the editor. The
background color of the notice is controlled by the "BACKCOLOR" statement in the PETRA.ini file in the
petrasrv subdirectory. An optional sound file will be played when the file is displayed. Examples of these
controls are below:
[NOTICE]
BACKCOLOR=255,255,183
; The three numbers indicate the value of Red, Green, and Blue
colors.
; The range is 0 (fully off) to 255 (fully on).
;
SOUNDFILE=<wave file>
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The notification message can be displayed at any time by clicking on the "Help > Show Notice Message" in
the main module.
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Controlling Data Modification

7.1

Restricting Changes By User Source
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The default setting in PETRA is to allow any member of the asset team to see and change any formation tops
within a project they can access. An optional data management feature allows an administrator to globally
define who can change any of the tops, regardless of the source of the tops, and who can only create, pick,
and edit their own formation tops.
In addition, certain "administrative" functions, such as, deleteing wells or changing the map project, can be
restricted to certain individuals.
This optional functionality is controlled in the PETRA.ini file, located in the petrasrv subdirectory. An example
is below.
[USERSOURCE]
;
; lines beginning with a semicolon are comments
;
ENABLED=1
BLANKS=1
ADMINLIST=hlm,tdw,bob
In the above example, the USERSOURCE control mode has been enabled and three people, hlm, tdw, and
bob are designated as administrators. Therefore, hlm is able to update tops for anyone in the group, but Sam,
who is not an administrator, can only create and update his own tops. With "BLANKS" enabled
(BLANKS=1), anyone can change a top that has a blank source code.
Restricting Access to project "administrator" functions:
If you set ENABLED=2 then only those users assigned to the "ADMINLIST" will be allowed access to
functions such as, deleting wells or change the map projection of a project.

7.2

User Restriction File (UR)

You can include a file called "UR" in the system (PetraSrv) folder or the "root" folder of a single project, if you
have a situation in which you wish to restrict one or more users from exporting data from a PETRA project.
When a user selects an export function in PETRA, a check is made for their log in name included in the UR
file. The user will receive a denial message and a record will be added to the project log file.
To implement the UR mechanism, create a text file called UR (no extension) and place it in the PetraSrv folder
(for all projects) or in the root folder of a specific project. PETRA looks first in the root of the project for the
UR file, then in the system folder.
The following is an example for a UR file to prevent two users from exporting data from projects:
! Petra User Restriction File (UR)
!
! Comments start with ! or /
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!
! Format is USERLOGINNAME,ACCESS,RIGHTS
! ACCESS: 3=Export, 4=Import, 0=Import and Export
! RIGHTS: 0=Denied,1=Allowed
!
Tom,3,0
Bob,0,0

Tom would be restricted from exporting data from all Petra projects (if placed in the system folder).
Bob would be restricted from importing and exporting data from all Petra projects (if placed in the system
folder).

7.3

Direct Connect Access Restriction

You can include a file called "DCUA" in the system (PetraSrv) folder or the "root" folder of a single project, if
you have a situation in which you wish to allow only specific users to use the IHS Direct Connect feature.
When a user selects a Direct Connect function in PETRA, a check is made to see if their computer login
name is included in the DCUA file. If the user is not listed in the DCUA file, they will receive a denial message
and a record will be added to the project log file.
To implement the DCUA mechanism, create a text file called DCUA (no extension) and place it in the
PetraSrv folder (for all projects) or in the root folder of a specific project. PETRA looks first in the root of the
project for the DCUA file, then in the system folder.
The following is an example for a DCUA file that allows only two users access to Direct Connect import
options:
! Petra Direct Connect Restriction File (DCUA)
!
! Comments start with ! or /
!
! Format is USERLOGINNAME
!
abc12345
xyz98765

When this DCUA file is present, only the two users listed will be granted access to the Direct
Connect well and production loaders.

Copyright © IHS Inc. - 2012

Database Management

8

Database Management

8.1

Project Password Protection
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The default setting is to allow anyone to view and/or edit a project if they have Windows permissions to
access the project subdirectories. As an option, it is possible to define a password for a project, which is then
required for any subsequent work in the project. To set the password, go to the PETRA main module menu
item "Project > Settings > Password Protect Project" and enter the desired password.

8.2

Force Shutdown of a Project

If a project database needs to be repaired or condensed, all users must be out of the project so all the
pertinent data files are available for exclusive use. It is easy to force a graceful shutdown of a specific project,
so that project database can be repaired even during regular business hours. All other projects will continue to
be available for use. NOTE: TO FORCE A SHUTDOWN OF ALL USERS IN ALL PROJECTS, SEE
THE SECTION ON "FORCE SHUTDOWN OF PETRA".
To initiate the process, simply place a file called NOTIFYKILL.RTF in the root directory of the project.
There is a default file called XNOTIFYKILL.RTF already available in the PETRA software directory
(typically \\server1\petrasrv). It is in a rich text format (rtf) and can be customized for your environment.
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Just copy the file to the root directory of the project and rename the file to NOTIFYKILL.RTF when you are
ready to initiate the shutdown of that particular project. Within 5 minutes, all PETRA users in that specific
project will be notified of the impending shutdown and told their data will be saved (via the NOTIFYKILL
message). Wait 10-15 minutes before proceeding with maintenance duties in order that all users have had
time to exit after automatically saving data. Some overlay files may take several minutes to write to disk.
If someone attempts to open a project while it is shut down, they will receive a message similar to the one
below.

To allow users back into the project, rename NOTIFYKILL.RTF back to XNOTIFYKILL.RTF.

8.3

Repairing Database Tables

Occasionally the database indexes get corrupted (due to a power failure on the local PC while it is writing data
back to the server, for instance). To repair these tables, PETRA provides a utility to verify and fix the
database. The utility is called PetraDBIRepair.exe and is located in the main PETRA subdirectory (usually \
\server\petrasrv).
Interactive Database Repair
After verifying everyone is out the project database, (or gracefully forcing everyone out of the desired project
- see section above) run PetraDBIRepair and click on the "Open" button and open the "*.ini" file for the
desired project. The program will show a list of database tables and give you the opportunity to select any or
all of the tables.
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Clicking on the "Verify" button will not change any of the tables, but will verify they are OK, generate a report
about the tables under the "Report" tab, and uncheck those tables that are OK. The "Repair" button will only
try to repair those tables that are checked on this screen.
Use the "ReIndex" button when to delete the table's index and rebuild it. "Repair" will also rebuild the index
but takes more time.
Use the "Optimize" button to remove unused space for the table. This should be done periodically after
deleting data from the database. It can greatly improve performance.

Batch Mode Database Repair
PetraDBIRepair.exe can also be run in Windows command line (batch) mode. The report is written to the
project's root folder as "PetraDBIRepair.txt".
The general format is:
PetraDBIRepair.exe projectini (optional switches)
"projectini" is the full path name of the ini file located in the project's root folder.
The following switches are optional:
/NOVERIFY = Do not verify any tables
/NOREPAIR = Do not repair any tables
/REPAIRALL = Repair all tables regardless whether or not there are any errors
/ARCHIVE = Create zip files of all files prior to repair
/KEEPOPEN = Prevents the GUI from closing when complete
/NOPACK = Suppress packing tables and removing orphaned records
The default mode is to verify all tables and repair any table that verify flags as having problems.
PetraDBIRepair will only work on projects that are not open by any other processes, including PETRA itself.
Therefore, it may be useful to force closing of PETRA and the database files before attempting a repair. See
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"Force Shutdown of PETRA" for details.

8.4

Enhanced Repair Tools

PetraDBIRepair.exe has been split from one application into two applications, DBIRepair.exe and
PetraRepair.exe.
DBIRepair.exe is a stand-alone command line driven application. You can use it to verify, repair, reindex or
optimize one single table in a PETRA project and then it ends. The operating system will assign one CPU
core and allocate memory for each DBIRepair.exe process. You can write your own scripts to launch
DBIRepair.exe on as many individual tables as desired in as many PETRA projects as desired. The operating
system will assign a core and memory individually to each DBIRepair.exe process you start… making more
efficient use of available hardware. Modern (Windows Vista™ and beyond) operating systems do all the
work of managing the CPU cores and memory per process. Windows XP™ will work somewhat but is not
recommended and could actually be slower, as it was developed before the widespread use of multi-core
hardware.
PetraRepair.exe is completely optional. It is simply a GUI front end that will ask you to select a PETRA
project, verify the tables you want processed have check marks beside them and automatically launch a
DBIRepair.exe for each table with a check mark beside it on the screen, so you don’t have to create your
own script and it looks and feels a little like the original PetraDBIRepair.exe. Do not be alarmed by the
number of individual DBIRepair.exe screens that pop up on the monitor and then one by one disappear!
There is NO command line option for PetraRepair.exe as you can bypass PetraRepair.exe and write your
own scripts to launch as many DBIRepair.exe processes on as many tables in as many projects as desired.
DBIRepair.exe
DBIRepair.exe is a new command-line tool for scripting PETRA database verification, repair, reindexing, and
optimization.
DBIRepair.exe is able to accept a full path filename to a single PETRA table (with automatic VERIFY and
REPAIR, if necessary) with parameter switches for FORCEREPAIR, REINDEX and/or OPTIMIZE (for
scripting). DBIRepair.exe requires exclusive access to the table (all users must be out of the project). There
is a separate report .txt file created with the same name as the table in the same folder as the table for each
table processed containing any exceptions during the process.
The format for the command line is:
DBIRepair.exe fully_qualified_path_and_table_file_name \FORCEREPAIR\REINDEX \OPTIMIZE
fully_qualified_path_and_table_file_ name
database table (see note 1)
\FORCEREPAIR
(optional, see note 2)

Specifies the full path to the PETRA
Forces a full repair of the table
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(optional – see note 3)

Reindexes the table

\OPTIMIZE
(optional – see note 4)

Optimizes the table
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Notes:
1. DBIRepair.exe with just the fully qualified path and table file name on the command line will automatically
perform a Verify. It will automatically perform a Repair, if it is found necessary by the Verify. This is the
safest and fastest option, since a Verify only reads the data and doesn’t have to write any data to a new
table.
2. \FORCEREPAIR is optional and will bypass the Verify and force a Repair even if it is not necessary. This
is a longer process as it has to create a new table to write the data into.
3. \REINDEX is optional and will delete the existing index(es) on a table and create them again from scratch.
4. \OPTIMIZE is optional. It will create a new table and write the existing data in the order of the primary
key index, effectively shrinking the file size by eliminating any deleted data. It will speed up data access
somewhat as the data will now be stored on disk in the actual index order.
5. All users must be out of the project before any repair processes are started.
6. Backup (copy and zip) your PETRA project folder before any repairs are undertaken.
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PetraRepair.exe
PetraRepair.exe is a graphical interface for the DBIRepair.exe command-line application. It is similar to
PetraDBIRepair.exe and makes it easy to verify, reindex, repair, and optimize an entire PETRA project.
PetraRepair launches separate DBIRepair processes to work in parallel on each table in the PETRA project.
Windows™ manages these multiple processes and assigns them to different cores of the processor and
separate areas of available memory per process. This reduces the total time per project as each table is
processed in parallel on multiple cores and separate memory spaces.
Notes:
1. All users must be out of the project before any repair processes are started.
2. Backup (copy and zip) your PETRA project folder before any repairs are undertaken.
To start PetraRepair, simply double-click on the file (PetraRepair.exe) in your PETRA installation directory:

Copyright © IHS Inc. - 2012

Database Management

44

Click the “Open” button to choose the .ini file for the project you would like to repair (in the PARMS folder):

By default all the tables are checked. If you would like to only repair some of the tables, select them now:
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The default for PetraRepair (no check boxes selected at the bottom) is to verify the tables and “automatically”
repair only tables with a problem.
Click “Start” to launch DBI Repair for each table with the appropriate switches:
Do not be alarmed by the number of individual DBIRepair.exe screens that pop up on the monitor and then
one by one disappear!
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PetraPack.exe
PetraPack.exe is now separate and can be run at any time (without having to kick anyone out of the project).
It will accept a command line full path to a Petra project .ini file (for scripting) or an open dialog will appear
for .ini selection, if the command line is left blank.
PetraPack can be launched once for different Petra projects and the operating system will assign each process
to separate cores and memory space. This allows packing of more than one Petra project at a time, making
use of the available cores and memory. A report .txt file with the same name as the .ini file will be created in
the folder with the .ini file containing information about the pack (before and after record counts or any
exceptions during the process).
Notes:
1. Backup (copy and zip) your PETRA project folder before any repairs are undertaken.
2. It is recommended but not required that you Verify, Repair and Reindex your tables before packing them
with PetraPack. exe, since PetraPack.exe relies on a table and index that is not corrupt to correctly
determine what records are orphaned and need to be deleted. Otherwise, you might delete records that
appear orphaned because of an error in the table or index when the records are really not orphaned, but
rather their parent just cannot be properly located.
3. Launching PetraPack simply opens a dialog for you to choose the project:

PetraPack then runs the Pack function on all that project’s tables as below
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Moving Externally Referenced Data

8.5.1

Moving Raster Images
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In large multi-user environments, raster images (logs and georeferenced images) are typically stored in
subdirectories separate from the PETRA database files. If these images are moved to another server, the
links or paths to the files in the PETRA project are no longer valid and need to be updated. There is a shortterm temporary solution to search additional paths if the images are not found in their original locations, but
this solution can dramatically slow response and increase network traffic.
SPECIFYING AN ALTERNATE SEARCH PATH ( IMAGESEARCH.TXT )
If your images have been moved from the locations originally assigned in the project, a temporary solution is to
tell PETRA to search additional paths for the images it doesn't find. This is done by placing a file called
IMAGESEARCH.TXT in the PETRA program folder (where geoplus1.exe is located). This file must contain
one or more entries (folder names) where the images and/or calibration files are located. PETRA searches the
folder and all subfolders listed in this file for images and LIC files. If the folder name is preceeded by a minus
sign (-), then subfolders are not searched. The "local" copy of IMAGESEARCH.TXT can also be placed in a
project's images folder and is used in place of the "system" file.
TEMPORARY SEARCH THROUGH ADDITIONAL PATHS (BY USER)
As an alternative to using the IMAGESEARCH.TXT file, you may set up alternate search paths for each
individual user. In the main module, go to "Project > Settings... > Program Options" and select the "Files" tab.
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In this example, the raster logs have been moved to H:\geology\Raster Images (TIFF)\Texas, so adding that
path to the list (as shown above) allows PETRA to find the images and display them. PLEASE NOTE: Be
very specific about the paths. If you put a generic "H:\" or "\\server1\", it can take a long time to search every
subdirectory in the path.
It is better to update the tif and LIC files to point to the new locations, and not use this temporary solution.
See the following sections for details.
This dialog box also allows simple remapping of drive letters in the "Image File Drive Mapping" section of the
dialog box.
UPDATING LINKS TO RASTER LOGS
There is a tool built into PETRA to make it easy to change the links for raster logs after the raster logs have
been moved. In the main module, go to the "Raster" tab, and click on the "Maintenance" button. Then go to
the "Misc Tools" tab of that dialog box. There is a pull down menu with a variety of choices, including "Find/
Replace tif/LIC paths". Select that option, provide the names of the paths and click on the "Perform Task"
button. This will replace the old path with the new path.
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In this example, the images have been moved from c:\geoplus1\projects\SanJaun\Images to \\server1
\projects\SanJuan\Images.
UPDATING LINKS TO MAP IMAGES
When images such as georeferenced topo maps and small images of cross sections or an index map are
moved from their original locations, there are tools within PETRA to either manually edit the link or
automatically edit the link. Both options are located in the map module under the menu item "Overlay > Layers
and Preferences". Click on the "Images" tab and then click on the box labeled "List Image File Names" to see
the paths of all images referenced in the overlay.

To manually edit an invalid link, click once on the listed link, click on the "Rename..." button, and then enter
the new path. To automatically update the paths, click on the "Locate Images" button.
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This will bring up the dialog box confirming that it is to scan the list of image paths in this project (described in
the beginning of this section) looking for the file names listed in the previous dialog box. Clicking on OK will
launch a search and if the images in the overlay are found in one of the other paths, PETRA will automatically
update the path. IMPORTANT: Save the overlay back to your server, so the changes will be available next
time you open the overlay.
8.5.2

Moving Hyperlinked Files

PETRA has a feature that allows it to store a file path to an external file and then with a couple of mouse
clicks, hyperlink to that file. This causes the operating system to start up the appropriate application and then
open that file in that application.

The drilling reports are tif images stored on server1, the well reports are html files stored on the company
intranet, and the geology reports are Microsoft Word documents stored on the (mapped) "H" drive. If any of
these file groups are moved, then the paths in PETRA are no longer valid. (NOTE: The tank battery diagram
tif image for this well is in a subdirectory called "REPORTS" that is located under the folder for this particular
project. The "@:" characters indicates the path is a relative path, not an absolute path. When the project is
moved, the relative path is still correct and will not need to be changed). For example, to link a file,
"REPORTS\Sample.txt", you would set the hyperlink to "@:REPORTS\Sample.txt" or "@:
\REPORTS\Sample.txt'.
To change the paths to these hyperlinked files, use the PETRA spreadsheet module, select the column to be
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edited and use the standard "find and replace all" option to change the paths.

8.5.3

Temporary Raster Folder

When working with "associated" raster log images such as those from IHS or MJ Systems, temporary image
files are created to improve performance. The default folder for these temporary raster images is the user's
"private parameters" folder. An entry in the GEOPLUS.INI file (client machine) can be added to specify the
location for storing temporary raster log images. The following line should be added to the [STARTUP]
section of GEOPLUS.INI:
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[STATUP]
TEMPRASTERDIR=<fullfoldername>

8.6

Copying and Renaming Project Files

8.6.1

Copying project databases

PETRA provides a project moving tool to make it simple to move a project database from one location to
another. The utility is called CopyProj.exe and is available in the petrasrv subdirectory.

To copy a project, run CopyProj, click on the "Open ini..." button, search for the desired project "ini" file and
fill in the desired name and new paths, as shown in the example above. Click on the "Copy" button to initiate
the copy process. Note that this will not automatically move any external files, such as raster logs, topo maps,
or files referenced in hyperlinks in the zone tables. Those links will remain pointing to the original paths. If the
raster logs were also moved, then the ideal solution is to also change the references to the raster tif and lic files.
A temporary solution is to insert the new image path in the list of paths to be searched in the project. This
temporary solution is quick to implement, but can cause slowdowns and extra network traffic. Therefore it
should be used with caution. See the section on Moving Raster Images for details.
8.6.2

Changing "ini" Pointers

The inifix.exe utility is used to change the paths in an individuals project *.ini files after the project files have
been moved to a new server or subdirectory. Enter the path to search for .ini files in the first window. Then
enter the beginning part of the paths for the projects that have been moved in the "FIND" field, and the
beginning of the new project path in the "REPLACE" field. In the example below, several projects are to be
moved from the local drive (c:\geoplus1\projects) to a network server (\\server3\petra\projects).
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The default setting when starting this utility is to NOT change the paths, but to generate a report indicating
what would get changed if the "Test (report only)" box is unchecked. In the above example there are two
"from-to" entries for each project because the private data path was the same as the public data path and the
utility is showing that both would be changed.
8.6.3

Renaming Project Databases

The Copyproj.exe utility is also used to rename an existing project. See the Copying Project Databases
section of this chapter for details.

8.7

PetraSync Program

The PetraSync.exe program can be used to copy data directly from one project (source) to another project (target) database.
This program is located in the Petra "system" folder, normally, "petrasrv".
Important - No one else can be accessing the two projects.
The following data types can be copied from one project to another:
Well Headers (operator, lease name, etc)
Well Zone Items (KB,TD,etc)
Locations (latlons,xys, Congressional, Texas, Offshore) (Dir Survey NOT included)
New Zone Definitions
New User Zone Items
Existing User Zone Items
New Tops (allows selection of individual tops)
Existing Tops (allows selection of individual tops)
New Digital Logs (allows selection of individual logs)
Existing Digital Logs (allows selection of individual logs)
"Change Dates" are utilized to determine if data from the source project is newer than the data in the target project.
It is copied only if the source data is newer than the target data.
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8.8

Monitoring Access

8.8.1

Logging User Access

The following is a fragment of the PETRA.ini file (located in the petrasrv subdirectory) pertaining to tracking
login and logouts of PETRA users. This logging is an optional feature of PETRA and must be enabled by
setting the LogProjectAccess=YES flag and defining a valid path for the log file. Lines starting with ";" are
comment lines. Note all users must have read/write access to this log file.
[NETLOGIN]
;------------------------------------------------------; ****LOGIN LOG FILE****
; Network version login monitoring log file. This file
; will contain date-time stamp of each time a user
; acquires or is denied a Petra network license.
;------------------------------------------------------; uncomment and put path to common location that
; all users have read/write access to
;
LogFileName=\\server1\petrasrv\petralogin.txt
;
;
set LogProjectAccess=YES to have the user's project name added
to
;
the login file to track opening and closing Petra projects
LogProjectAccess=YES
The resulting file will have each opening and closing of any project listed in the petralogin.txt file. The latest
transaction is at the beginning of the file, and the oldest is at the bottom of the file. A simple example of a single
opening and closing is below:
Joseph Bleaux,1/17/2005 5:22:52 PM,Closed: d:\geoplus1
\projects\SoonerDemo
Joseph Bleaux,1/17/2005 3:43:02 PM,Opened: d:\geoplus1
\projects\SoonerDemo
When the file gets too big, it can be renamed and saved for historical reasons. PETRA will create a new
"LogFileName" the next time someone logs in or out of PETRA.
8.8.2

Logging Map Projection Changes

A "log" file is written each time a user changes the map projection in a project. Records are appended to a file
called MAPPROJ.LOG which is located in the root of the project (public) directory. This file can be used as a
record of when (and who) changed the map projection settings. These messages are also written to the
PETRALOG.TXT file (see Logging Project Changes).
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Logging Project Changes

PETRA keeps a "log" file called PETRALOG.TXT in the project root directory (i.e. \\server1
\projects\gulf_offshore) containing various project related changes, such as deleting wells, changing projection
(which is also in mapproj.log), footage calc parameters, loading/saving overlays, and deleting seismic lines.
8.8.4

User Profile INI File

A User Profile INI can be supplied to provide detail user information when PETRA logs various data changes
in the Project. The profile contains user information that is associated with the "login" name.
The file is called USERPROF.INI and must be placed in the "system parms" folder. By default this folder is ..
\petrasrv\parms for a network install.
The contents of the USERPROF.INI file are as follows:
There is one Section for each user "login" name.
The section name must match the user's login id.
The following Value fields are available and limited to 64 characters each:
NAME=
DEPT=
DESC=
PHONE=
EMAIL=
NAME is the only required field at this time.
Example of two entries in a sample USERPROF.INI
[mxz27455]
NAME=Tom Whitwell
DEPT=PETRA Development
DESC=Lead PETRA Architect
PHONE= xxx-xxx-xxxx
EMAIL=xxxxxxx@xxxxxxxxx.com
[bke28543]
NAME=H.L. Moore
DEPT=PETRA Technical Support
DESC=Senior Technical Analyst
PHONE= xxx-xxx-xxxx
EMAIL=xxxxxxx@xxxxxxxxx.com

8.9

Location of Temporary Database Tables

When using the DBI database engine PETRA occasionally uses SQL queries that create temporary results on
disk. The default location of these temporary query files is the user's private parameters folder. This can be
overridden to use the PETRA "client" parms folder (i.e., geoplus1\parms) using an ini setting.
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To override the temporary file location for all users, add the following statements to the PETRA.INI file
located where the PETRA executables are located:
[DBI]
LOCALTEMPDIR=LOCAL
To override the temporary file location for a single user, add the following statements to the GEOPLUS.INI
file located in the PETRA "client" folder:
[DBI]
LOCALTEMPDIR=LOCAL

8.10

US IHS Raster Import

When importing US IHS Rasters, it is best to import them using the version 2 XML "RasCal" format.
You will have more flexiblity over group names.
"PARMS\USIHSLOGNAMES.TXT" Translation File
This is a translation file that can be provided when loading the XML files. This file is used the translate logs
with multiple log types into a preferred log type.
USIHSLOGNAMES.TXT must be placed in the "system" PARMS folder, i.e., petrasrv\parms for network
installs or geoplus1\parms for local installs.
For example, a log might contain a IHS-provided log type of
CALIPER/GAMMA RAY/DENSITY
The sample translation file below would translate this to a PETRA group name of DENSITY
based on the ordered preference in this file. The names are listed in most preferred to least preferred order.
The log type will remain untranslated if a match cannot be found.
Sample USIHSLOGNAMES.TXT File:
INDUCTION
RESISTIVITY
DENSITY
NEUTRON
NEUTRON/DENSITY
SONIC
GAMMA RAY

8.11

Batch Updates From IHS Enerdeq

.

8.11.1 Batch Well Data Imports
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CREATE WELL IMPORT BATCH IMPORT COMMAND FILE:
1) Open Petra and select Enerdeq Well Import option
2) Establish an area of interest (AOI). Batch well imports require an AOI.
3) For Updates, be sure to set the "Last Change Date" to something like
"Last 30 Days to reduce the amount of downloaded data.
4) Select the appropriate "Import Options". Batch well imports always use the
option to "Update any well in the database and you cannot select individual Fm Tops.
5) Select "File>Save Batch Command INI File" menu.
6) You will be asked to first save a file containing the import options
(.IWL) followed by the name of the command (.INI) file.
TO RUN THE BATCH WELL LOAD:
From a command line or script enter the following line:
<program path> <command file>
Replace "program path" with the path to the folder containing the Petra well data loader program.
For example, H:\PETRASRV\IHSLOADER.EXE
Replace "command file" with the full path name to the command (ini) file saved in step 6 above.
A log file is written to the Petra "system" folder (petrasrv). The name of the log file is
IHSLOADER_yyyymmdd_hhmmss.LOG
Upon successful completion of the batch import, a copy of this log file is placed into the
"Reports" folder of the project.
8.11.2 Batch Production Imports

CREATE PRODUCTION BATCH IMPORT COMMAND FILE:
1) Open Petra and select Enerdeq Production Import option
2) Choose the method "I'll Decide Later".
3) Set the import options. For Updates, be sure to set the "Last Change Date" to something
like "Last 30 Days to reduce the amount of downloaded data.
4) Select "File>Save Batch Command INI File" menu.
5) You will be asked to first save a file containing the import options
(.IPL) followed by the name of the command (.INI) file.

TO RUN THE BATCH PRODUCTION LOAD:
From a command line or script enter the following line:
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<program path> <command file>
Replace "program path" with the path to the folder containing the Petra production loader program.
For example, H:\PETRASRV\IHSPRODLOADER.EXE
Replace "command file" with the full path name to the command (ini) file saved in step 5 above.
A log file is written to the Petra "system" folder (petrasrv). The name of the log file is
IHSPRODLOADER_yyyymmdd_hhmmss.LOG
Upon successful completion of the batch import, a copy of this log file is placed into the
"Reports" folder of the project.

8.12

PETRA File Extensions

Extension
--------ALI
API
ASC

ATT
AXP
BAK
BMP
BUB
BXO
BWL
CDF
CGM
CLR
COL
CON
CPS
CPT
CSL
CSP
CST
CSV
CTB
DAT
DBW
DEF
DLS
DMP/DMP2
DPS
DRA
DRI
DVP
DXF
EMF
EXP

PETRA File Type Description
-------------------------------------------------------Files that contain aliases
API (UWI) Old Versus New API List
ASCII/Text Data File (Can be a PETRA ASCII Well Data Import File,
Generic ASCII or a Landmark Standard 29 Format File, or a Landmark
OWX Format File, or a RC2 curve file export)
Attribute Map Template
Accumap PETRA Production Import
Overlay Backup File
Bitmap File
Bubble Map Template
Cross Section Overlay Backup File
Build Well Labels Template File
Geographix Cartographic Data Format
Larson's Plot file - Uses EMF file to create CGM File
Display "Colors"
Color Settings for Enhanced Colors
Display Contours Template
Log Cross Plot Settings
Control Point File
List of Cross Section Lines to be displayed on the Map.
Saved Cross Section with wells, overlay, and template
Cross Section Template
Export/Import File for loading Well, Dir Survey, tops, and other data
Cross Section Title Block Template
ASCII/Text Data File
Map Data Posting Template
System Definition File
Export Default Log Scales for Log Maintenance
Dwight's Detail Production data File
Log Depth Shift - Save Depth Pairs
Geographix "DRA" Log Image Calibration Files
Drilling Info (V2 Format) File
Map Overlay Preferences
DXF Plot File
Enhanced Windows Meta File - 32 Bit
A2D SmartRaster(TM) Old Format
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F10
FM1
FM2
FM3
FM4
FM5
FM6
FM8
FM9
FMT
GDT
GES
GRD
HS
HST
IOG
IPP
LAS
LAB
LBS
LAY
LIC
LIM
LIS
LIX
LMA
LOG
MAP
MLP
MOR
MPT
MTB
OVG
OVL
OVO
OVP
ORD
OWX
OXP
PAS
PAT
PDO
PET
PMO
PPF
PPT
PRO
PTF
PTX
PXP
QRY
QSG
REG
RPT
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Footage Summation Template
Tabular Well Data Format
Save Import Seismic Input
Tabular Monthly Production Data Format
Save Export Tabular Well Data Format
Save Export Tabular Seismic Data Format
Tabular Log Data Format
LAS - Load Header Template
Log Equation Template
Import ASCII Overlay
Grid Display Template File
Import/Export GES Wellbase ASCII V2 Files
Grid Files
Histogram Module "Save "Settings"
IDP Production History Files
Red Top Digital Data Services Well Data
IP Postings
LAS log data files in either 1.2 or 2.0 format - ASCII
Custom Well Label File
Log data files in Binary and ASCII
Map Overlay Layer File
Log Image Calibration File
Map Data Limits File
Industry standard Log Files in LIS format – Binary
Back up of LIC files when they are replaced by PETRA.
User Model Log Assignments
Save Log Definition Scale Parameters for Cross Section
Map Settings and which overlay file that was saved
Log Map Template
MORE Simulator - Log and Production Export
Map Projection Settings
Map Title Block Template
Overlay Group Definitions
Overlay File
Overlay Layer On/Off Flags
Map Overlay Preferences
Order
Landmark OWX format (ASC)
Cross Plot Overlay File
Production Analysis Module Settings
Production Pattern Definition File
Production Chart (Main) Template
PETRA ASCII Well Data Format Import File
Production Chart Map Template
PETRA Project Import/Export File
PETRA Project Template File
Prospect Well List
PETRA Template File
Dwight's Power Tools - PTX Production File
Petra Well Export From Accumap
Select Wells by Data Criteria - Saved Query File
Quarter Section Grid
LogSleuth Version 1 or 2 Files
Report File (Like Scout.RPT) (NOTE: this has been changed to TXT as
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SEG
SHP
SHT
SIF
SLL
SMT
SRV
SSC
SSS
TIF
TXT
USR
UWI
V2
VOL
WCS
WDI
WDS
WLX
WMF
WSN
WSP
XPO
XPP
XSO
XSW
XTP
XYZ
ZIL
ZOL
ZPL
ZSC
065
97F

98C

PETRA Usage in Large, Multiuser Environments
Word had problems opening files with a .RPT extension)
Contour Capture File
Shape Files
Symbol Highlight Template
A2D New Interchange Calibration File Format
Seismic Selected Line List
Seismic Mapping Template
Export Directional Survey
Spread Sheet Columns Definition
Spread Sheet Template
Tiff Image File
ASCII/Text Data File
Saved Equations – User Files like Symtrans.usr
UWI List File
Lasser V2 Production File
Volumetric Report
Tobin Well Coordinate Service File
Popup Menu (Map) Well Data Template
Dwights WDS File
Landmark OWX Format File
Windows Meta File - 16 Bit
Well Sequence List File
Well Selection Polygon
Log Cross Plot Overlay
Log Cross Plot Polygon File
Cross Section Overlay File
Cross Section Post Template
Cross Section Tops Template
Grid Export (MCS, SCA, XYZ Files)
Zone Item List
Saved Z Order List
Color Palate Template
Z Colors Scale Template
PD CUM Report Template
IHS Well data Files, Fixed or Comma Delimited format is acceptable
297 files are year 2000 compatible, 97 and 197 files are not year
2000 compatible)
IHS Production data Files, Comma Delimited format only (298 files are
year 2000 compatible, 98 files are not year 2000 compatible) DMP and
DMP2 files can be loaded as well, but are not recommended. The DMP2
format is the best one to use if you can only get the DMP or DMP2
formatted files due to the IHS CD-Rom formatting error when exporting
the DMP files)

Database engine file extensions
The "DBI" extensions are .DAT, .IDX, & .BLB
The "BDE" extensions are .DB, .MB, .PX, .VAL, .XG0, .YG0, .XG1, .YG1, & .YG2 (NO
LONGER USED)
The "ADS" extensions are .ADI, .ADM, & .ADT

(NO LONGER USED)

If you have a mixture of engine extensions, you can delete the files for the
engine that is no longer being used or you can run the PetraDBZip program to zip
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the desired engine files (ADS and or BDE). Use the "Move" option to delete the
file after they are zipped. Once you have a backup of the files, they can be
deleted.
To determine the database engine you are using, open PETRA, click on the
"Help>About PETRA" menu in the "Main" module or click on the PETRA logo at the
bottom right of the "Project" tab if you have a recent version of PETRA.
In red at the bottom of the screen the following will be displayed:

For "DBI" you will see: "Using Local DBI Database Server" (Note: This is the only engine that will be
available after March 31, 2006 for updates to PETRA. The other engines will no longer be supported.
For "BDE" you will see: NETDIR: (There will be a path to where the
PDOXUSRS.NET file is written.) for instance NETDIR: D:\Petra_Lck
For "ADS" you will see: "Using ADS Local Database Server"
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9

Performance Issues

9.1

Anti-virus Scanning

If your anti-virus scanner is checking all files,

which is a typical default, then it will significantly slow access to
large, shared projects. To speed response time, change the scanner to prevent it from scanning the following
file types: .DAT, .BLB, and .IDX. These file types are used by the PETRA DBI database engine. If you are
using an older version (BDE or ADS), please contact our customer support team for assistance.
Please note: some tools, such are Norton AntiVirus with its SmartScan provide a list of file types TO BE
scanned. In that case, verify the above file types are not on the list.
Some anti-virus software provides the option to turn off all scanning in particular folders. If you use that
option, set it to the upper level for the projects.
Some virus scanners have been known to automatically delete temporary database tables created from SQL
queries, which then creates runtime errors. See "Location of Temporary Database Files" section for more
details.

9.2

Network traffic

There are many analysis tools in PETRA to make it easy to glean information from the raw data. Examples are
the computational tools under the "Compute" menu item in the main module, and the Attribute tool in the cross
section. Since PETRA can efficiently handle large numbers of wells, there are many times when users put a
great deal of traffic on the network, searching through hundreds of thousands of wells for those wells that meet
multiple criteria, or computing a water saturation curve for thousands of wells.
This traffic can be very "bursty", and may not be obvious if you are looking at 5 minute averages.
The ideal solution for large volumes of network traffic is to increase the speed of the network to 1Gb, dedicate
one or more servers for just PETRA projects, and segregate the geoscientists so they are on a different
network segment than the business office and others. As the cost of hardware continues to drop rapidly, it
becomes easier and easier to approach an ideal network.

9.3

Overlay Files

The PETRA map overlay files are perhaps the least understood area of PETRA, and close attention to what
cartographic data gets loaded into layers, how the data are assigned, and how the layers are managed can
significantly improve responsiveness and minimize confusion.
IMPORTANT: Every person that is editing the overlay must have their own copy of the overlay file. If two
people open the same overlay file, make changes to it, and each save it back to the server, then the changes
made by the first person will be "lost" because the second persons overlay file replaced the first. SEE LAYER
MANAGEMENT SECTION BELOW FOR A WAY TO SHARE DATA.
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Duplicate or Obsolete Data
The overlay file can have up to 256 individual layers and each layer can be displayed or not. Sometimes the
same cartographic data can get loaded multiple times in one or more layers, causing the initial load time and
refresh times to be much longer than necessary. If the overlay file is greater than 50 or 60MB, then duplicate
data could be an issue. To remove duplicate data in an overlay, use the map module menu item "Overlay >
Edit > Delete Duplicate Items...". NOTE: This process can take a very long time, so MAKE A BACKUP of
the overlay file and then start the process before you go home in the evening.
Also, if data has been loaded into a layer and that layer is no longer needed, then that layer should be cleared.
Use the "Clear Layer" button on the Overlay Preferences and Layers dialog box.
Data Outside the Area of Interest
A common mistake is to load cartographic data for a very large area (i.e. Western Canada), even though the
project is in a very small portion of that area. Each time the map display is refreshed, the program has to scan
through each element in the file and determine if it is a layer that is to be displayed, and whether it is within the
area being displayed on the screen. Clipping out excess cartographic area and saving the result as a new
overlay file will speed up the refresh time and also reduce the load and save time of the overlay. When you
need to do the large regional work, simply reload the original (large) overlay.
Layer Management
It is common to have designated persons responsible for specific types of cartographic data. For example one
person is responsible for maintaining the section lines, rivers, highways. Another person is responsible for
maintaining the contour lines for subsurface tops. A third person is responsible for maintaining the lease
polygons. A technique to manage these files and make the current information available automatically each
time a team member opens their individual overlay, is to use the Associated Layer technique.
Associated Layer Technique
A common scenario that asset teams ask about when dealing with cartographic data: They have more than one
user working in the same project and have one or more persons (usually geotechs) designated to update
specific items, such as the lease holdings or contour lines. They also want each team member to add their
individual interpretations, text boxes, titles, etc. without clobbering other peoples work. Sound familiar?
A very good solution to deal with the overlay data that are frequently updated by one team member and
shared with all the other team members, is to use the associated layers. The designated person will update the
layer in the usual fashion, and save that layer in an agreed upon subdirectory that all others can access. The
other team members in the past have had to manually update their individual overlay files with several layer
files to get the latest data. This process is laborious and error prone if done infrequently and in a hurry.
However, by linking to a layer as an associated layer (rather than merging or replacing a layer with a layer file),
the data in that layer only gets loaded into memory if that layer is made visible. Each time the overlay file is
loaded (such as when you start the map module), the current information in the associated layer files are
loaded dynamically for each one that is turned on in the overlay. Therefore the other team members no longer
have to manually load the layer files to get each of the updates. The associated layers are read only, so the
possibility of accidental changes to the data (by someone not designated to change these data) is eliminated.
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Another great feature of the associated layer is that it is removed from memory when the layer is turned off.
The benefit is that the map can be updated much quicker, since PETRA does not have to go look at each of
the items in that layer to decide if it should be plotted or not. (When a standard layer is loaded into an overlay,
PETRA has to look at each item to determine which layer it is in, and then decide if that is one of the visible
layers). A case where this would be useful is when someone loads data into the overlay to be used in regional
maps (such as state boundaries and the townships for all western states), but spends a large percentage of
their time working small prospects in one or two counties. By loading these types of data into associated
layers, the map refresh time will be much quicker when they are working prospects that don't need those
layers turned on.
To create an overlay with associated layers, first have the person responsible for the managing the data (say
the leases) select the appropriate layer in an existing overlay and write that layer out as a layer file. This is done
in the map module menu item "Overlay > Save > Save Overlay Layer File". Then select the layer and provide
a file name. (NOTE: The overlay file can have up to 256 layers, but a layer file is just an individual layer). Then
have the person that needs access to that layer open up the map module and load the layer into one of the 256
layers, with the Associated Layer option selected. This does not actually load the data into the overlay file, but
instead makes a link to that layer file. Now, each time that person opens the map module with their own
overlay turned on, the latest information in the associated layer is automatically loaded if that layer is turned on.
It is possible to have multiple associated layers (one for the section lines, one for the rivers, one for leases, and
so on). When the data (in this example, the leases) needs to be updated, the data manager loads the layer file
into a spare layer in the normal way, makes the edits, and saves the file back in the same place with the same
name. Everyone with an associated link will see the updated leases the next time they open the map.

9.4

DBI Buffer Sizes

The PETRA database engine (DBI) uses client-side memory caching to improve performance for read-ahead
operations. The default setting for the DBI buffers is sufficient in most cases. A user can change these settings
for their connection to projects causing more data to be read into memory on each database read operation
and possibly speeding up read intensive operations, such as, map redraws. However, the bigger the buffer
size, the longer it will take to refresh and flush these buffers when the system requires it. This can reduce
performance in a highly congested network.

9.5

PetraSeis Trace Files

As an option , it is easy to copy the trace files from the server to a local disk and change a path in the .ini file
so PetraSeis will pull the trace data from the local file, rather than from the network drive. The advantage is
two-fold. The responsiveness of PetraSeis is much better when pulling trace data from a local drive. Also, the
amount of network traffic is much less, so there is less network performance impact on others on the network.

9.6

Database Compression

A project database can become slower as the database tables become larger. Continual data deletions and
additions can create "garbage" records that should be removed.
You should run the PetraDBIRepair utility program occasionally, to remove unused space and improve
performance.
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PetraDBIRepair.exe is deployed with the server version of Petra. Contact Petra support if you can not find it.
Make sure you have a good backup before proceeding !
From the PetraDBIRepair screen:
() Select the project's INI file
() Uncheck the "Archive (zip) Tables" option
() Check the "Pack Tables" option
() Click the "Optimize" button and wait...
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10

Exchanging Data with Other Systems

10.1

Import Formats supported by PETRA

WELL DATA IMPORTS
PETRA Well ASCII (used by data vendors, including Petro-Lab and others)
PETRA Project (used between PETRA project)
PETRA Template (used to define tops, logs, zones, and zone items)
Generic ASCII
IHS (PI) 97, 197, 297, 98, 298 Download
GDS-II
Geographix ASCII V1 and V2
Tobin WCS
NRIS (Oklahoma)
GCS
Dwights WDS
Landmark 3x Metafile, Standard 29, OWX
QC Data AXXses DPDT Request
IOG RedTop (Kansas)
SeisX Well Data
Drilling Info "DRI" (V2)
DIGITAL LOGS IMPORTS
LAS individual load, batch load
LIS
Tabular ASCII
MORE Simulator
MIRA format
RASTER LOGS IMPORTS
MJ Logs (exported and LogSleuth Direct Connect)
A2D SmartRaster™ (old and new SIF)
MMS (US gulf of Mexico)
Uncalibrated TIF files
Geographix "dra"
PETRA LIC
MONTHLY PRODUCTION IMPORTS
Dwights DMP, DMP2 Detail
Tabular ASCII
MORE History Match
Production Analyst "*NAME"
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OFM "KEYNAME"
Lasser V2 (Texas)
AccuMap ARIES
Dwights Power Tools PTX
IDP Production History
OGRE Monthly Production
IHS 298 Injection Data
DrillingInfo "DRI" (V2)
CARTOGRAPHIC DATA IMPORTS (for the Map Module)
Tobin Land Grid (old format)
GII or Tobin Infobase
Platte Rive Assoc. TwnRgeSec
Z-Map Plus Vertex
Z-Map Plus Text
Z-Map Plus ASCII Contours
Z-Map Fault File (x, y, SegID)
Landmark ASCII Metafile
Contour SEGID
Digitized Contours (x,y,z)
Digitized Contours (Lon, Lat, Z)
TMC TownShip/Range
TMC Texas Landgrid
Geographix Cartographic Data Format (CDF)
ESRI Shape File (x, y)
ESRI Shape File (Lat, Lon)
AutoCAD DXF (x, y)
AuotCAD DXF (Lat, Lon)
MapInfo Mid-Mif
InfoPipe Mid-Mif
GeoQuest CPS-3 Contours
SMT Planimeter Polygon
PETRA ASCII Overlay
GRID IMPORTS
Landmark Z-Map Plus Grid
GeoQuest CPS-3 Grid
Generic XYZ triplets
MORE Simulator Grids
GeoFrame Grid
USGS GXF Grid
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Export Formats supported by PETRA

PETRA WELL EXPORTS
PETRA Project (used between PETRA project)
PETRA Template (used to define tops, logs, zones, and zone items)
ASCII Tabular Well Data
ASCII Tops (UWI, Formation name, value, …)
ASCII Tops Definition (Formation name, source, description)
ASCII Zone Items
ASCII Directional Surveys
ASCII Perfs, Cores, Production Tests, Formation Tests
Landmark Standard 29 and OWX
PETRA to MJ LogSleuth (through direct connection)
Geographix GES V2 (Tops)
SCA-MCS (Tops and zone items)
DIGITAL LOG CURVE EXPORTS
Digital Log Curves (LAS 2.0, LIS)
RASTER LOG EXPORTS
PETRA LIC
MONTHLY PRODUCTION EXPORTS
Tabular ASCII
Production Analyst
More Simulator
CARTOGRAPHIC DATA EXPORT (from the Map Module)
PETRA ASCII Overlay
Z-Map Plus ASCII Contours (x,y)
Z-Map Plus ASCII Contours (Lat, Lon)
Landmark ASCII Metafile (Lines and Text)
Geographix CDF (Lines and Text)
GeoQuest Culture Format (Lines and Text as x,y)
ESRI Shape File (x,y Lines)
ESRI Shape File (Lat, Lon Lines)
ASCII Lat, Lon, Seg ID
ASCII x, y, Seg ID
GRID EXPORTS
Z-Map Plus Grid Format
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ASCII Tabular
ASCII Triplets (x, y, z)
ASCII Triplets (Lon, Lat, z)
More Simulator

10.3

ESRI Shape Files

The PETRA Thematic Mapper provides Graphical Information System (GIS) tools to open shape files and
query based on content, comparisons, and distances. The shape files can be filtered and colored and inserted
into the PETRA map module overlay for integration with all the other items available in the map module. The
Thematic Mapper can also generate shape files from the PETRA well database for comparisons within the
Thematic Mapper or for use by other programs.

10.4

Third Party Transfer Tools

As of this writing, there are two suppliers that have developed links between the PETRA database and other
packages. These companies are InnerLogix and Petris Technologies. A third company, OpenSpirit, is also
working on a link to the PETRA database.
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11

Troubleshooting

11.1

Terminating a "Hung" Network License

The following procedures are available for terminating a network license that is not actually in use by a user,
but is not available from the license manager.
NET HASP Licenses
There is currently no way to terminate an individual Net Hasp license without terminating all licenses by
stopping and re-starting the Hasp license manager ("hasp loader").
FLEXLM Licenses
A command line utility from Macrovision (creators of FlexLM) is available that allows the removal of a
FlexLM license that is hung. This command line utility is called "lmremove.exe".
The "lmremove.exe" file is deployed by IHS along with the other Flexlm utilities. If you can not locate
"lmremove.exe", you can download it from https://petraftp.ihsenergy.com/lmremove.zip and save it to the
petraflx folder or wherever you have LMTOOLS running. lmremove.zip contains lmremove.exe and
lmremove.txt,
which contains the "read me" information that follows.
To run "lmremove.exe", bring up a command screen. I use Start>Run and enter CMD to get my command
screen.
Change directories to the folder where LMTOOLS is located.
NOTE: You can obtain the information needed from the LMTOOLS dialog screen for lmremove.exe.
Click on the "Server Status" screen. Click on the "Perform Status Enquiry" button.
On the Command line prompt, change to the drive and folder where you are running LMTOOLS from.
On the Command line prompt, Enter lmremove PETRA user_login user_machine user_machine
For example to remove a hung license for logon user BRE25856 logged onto machine HLMXP you would
enter:
lmremove PETRA BRE25856 HLMXP HLMXP
on the command prompt line.

11.2

No License

Can't Get A License?
NETHASP LICENSE MANAGER
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CONFIGURATION:
Petra communicates with the NetHasp license manager through either the TCP/IP, IPX or NETBIOS
network protocol. If the client PC is not obtaining a license you may need to configure the license manager.
The NetHasp license manager is configured using an "INI" file called NETHASP.INI. This file is initially
located in the …\PetraSrv\NetHasp folder. Copy the NETHASP.INI file to the PetraSrv folder and modify its
contents using an editor such as NOTEPAD.
In the [NH_COMMON] section add lines to enable and disable the appropriate protocol, such as:
NH_TCPIP = Enabled
NH_IPX = Disabled
NH_NETBIOS = Disabled

You can also set the license manager server IP address in the [NH_TCPIP] section such as:
NH_SERVER_ADDR = 192.168.0.3
NH_TCPIP_METHOD = TCP
HN_USE_BROADCAST = DISABLED

This can speed up getting a license in a large network environment.
FIREWALL ISSUES:
Firewall settings for ports 475/UDP and 475/TCP must be enabled to allow the Hasp License Manager to
communicate with application. The newer "lmsetup" install file from Aladdin displays a screen allowing the
installation procedure to enable these ports. If you don't enable them at install time, you will have to enable
them by changing your firewall rules manually.
FLEXLM LICENSE MANAGER
Envirnoment Variables - One issue that can effect PETRA's ability to obtain a Flexlm license is the use of
environment variables by the flexlm license manager. PETRA does not use or require such environment
variables, however, some other applications do. These environment variables can redirect the flexlm license
manager to a specific license file which might not contain the PETRA license information. The solution is the
remove the environment variables or add the PETRA license information to the appropriate license file.
For further details, see "Installing FLEXLM License Management".

11.3

NetHasp Install

We have received a few reports from customers with AMD64 and XEON processors that the standard
hdd32.exe Hasp installation did not work. Downloading https://petraftp.ihsenergy.com/haspusersetup.exe and
running it before running hdd32.exe seems to resolve the problem.

11.4

Random Errors/Write Delay Errors

PETRA has been tested in a pure Microsoft Windows environment and is supported in that environment.
Occasionally we hear of problems with shared projects on network attached storage (NAS) systems. There
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appears to be a variety of configuration options on these NAS systems, and if not configured properly, they
don't fully mimic a Windows server. One particular option is to toggle the state of the "OPLOCK" flag if there
are issues with random access violations. The delayed write error is a known issue at Microsoft. Check the
Microsoft Knowledgebase for details on resolving that issue.

11.5

Long Map Load Times

OVERLAY SIZE
One of the biggest issues with long load times for the map module is the amount of extraneous data in the
overlay file. See the section under "Performance Issues - Overlay Files" for details.

11.6

Long CrossSection Load Times

Raster Logs can be relative inexpensive to obtain, but require a hefty CPU and lots of RAM to display in tools
such as the PETRA cross section module. There are two options in the cross section to control how rasters
are loaded and retained in a cross section.

In general, the best choice is to keep the rasters in memory (RAM) while working with a specific set of wells.
However, there may be certain conditions (minimal RAM, highly fragmented local disk) where the
performance may be better with the option to always load from memory.
If the user is doing a "quick look" at a lot of raster logs, and has many different names of raster groups, it is
common to tell PETRA to display many raster groups in track 0, which is centered below the well spots. If
any of the wells in the cross section has several rasters in the same track, only the last raster will be displayed,
and time will be wasted as PETRA repeatedly overlays previous rasters with additional rasters in that track.
To eliminate this issue, there is an option available to prevent scaling and displaying of multiple rasters in a
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track. This option will display the first available raster on the list and then move on to the next track or the next
well. Setting this option can dramatically improve display times in this situation.

11.7

Lost Project Password

Password protection for a project or map projection is an optional feature. If the password is forgotten,
deleting the password file will remove the password from the project. The following password files are located
in the "public parms" folder of the project:
PSWD.BIN - Project Password
MPRJPSWD.BIN - Map Projection Password

11.8

Can't View Help File

The PETRA help file is called "GEOPLUS1.chm" and is located in the PETRA system folder, ie, the folder
containing the PETRA program files. The help file requires an HTML viewer to display help information to the
user.
PROBLEM: HELP FILE IS STORED ON A NETWORK DRIVE
When the help file is located on a network drive, as in a typical PETRA network install, Windows may not
allow HTML files to be viewed across a network. As of release 3.1.9.0, PETRA was modified to copy the
help file to the user's "client" path. However, if the client path is also a network drive, this copy may not be
viewable either.
SOLUTION 1:
The help file must be copied to the user's local drive. This can be automatically by PETRA when you add the
following statements to the user's GEOPLUS.INI file (located in the client folder).
[STARTUP]
ALTHELPPATH=c:\........ (what is appropriate)
SOLUTION 2:
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Another way to resolve this issue is to make the following Registry entry change on the user's PC:
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[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\HTMLHelp\1.
x\ItssRestrictions]
"MaxAllowedZone"=dword:00000001

11.9

Error Opening a Project

If you get an error loading wells when first opening a project, such as code 222, you might try the following procedure.
Hold down the SHIFT+CTRL keys as the project is opening.
This causes PETRA to ignore the last list of WSN displayed and instead loads all wells from the database.
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Document Revision History

This section provides the revision history of this document.
Aug. 29, 2005
Software Update - Expanded this section to describe new feature to force shutdown of PETRA and
automatic closing of open PETRA projects. This tool is to ensure all necessary files are closed before updating
PETRA or repairing PETRA projects.
Creating a Notice Page - Added new sound wave option.
Repairing Database Tables - Added new batch mode capability to automate the process of verifying or
repairing PETRA project files.
October 6, 2005
Added section on "Migrating to Citrix" under Software Installation and Updates Chapter.
October 28, 2005
Database Mangement - Added section on "Force Shutdown of a Project" to describe the process of shutting
down a specific project, so the database can be available for moving or repairing it.
November 22, 2005
Database Management - Added section on "Location of Temporary Database Tables".
December 1, 2005
Database Management - Documented NOPACK option on database repair utility.
February 16, 2006
New "The PETRA.INI File" section was added
Database Management - User Restriction File (UR) added.
Miscellanous minor changes
April 5, 2006
Added comments about NetHasp firewall rules to trouble shooting section
Added comments about Flexlm environment variables to trouble shooting section
Removed overaly temp work file notes from trouble shooting section
Added DBI buffer size comments to Performance Issues
June 26, 2006
Added section called "Moving Externally Referenced Data for IMAGESEARCH.TXT
Removed "geoPLUS Corporation" references
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February 21, 2007
Added troubleshooting section for terminating a "hung" license.
May 14, 2007
Added troubleshooting section for "can't view help file".
June 1, 2007
Added notes for batch import of IHS Enerdeq data
February 20, 2008
Added User Application Launch info to the [GENERAL] section of the PETRA.INI
March 26, 2008
Added MODIFYPLACESBAR entry to the [GENERAL] section of the PETRA.INI
October 7, 2008
Added GOOGLEMAP and GOOGLE_WGS84_DATUMSHIFT entries to the [GENERAL] section of the
PETRA.INI
October 15, 2008
Added SAVEDEFAULTPROJECTION and ALLOWUSERPROJECTION entries to the [GENERAL]
section of the PETRA.INI
June 4, 2009
Added BKGNDSCAN and BKGNDSCANTIME entries to the [GENERAL] section of the PETRA.INI
February 4, 2010
Added section to IHSCAN section
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